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Published on MuseScore (https://musescore.org)

This handbook is for MuseScore version 3.0 and above. It is maintained and translated by the MuseScore community Find out how you can help & In case of doubt
consult the English online version of the handbook &

(If you are still using MuseScore 2.x, you can accessthe old handbook ).
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Tours will help guide you through the functionality of MuseScore.

Would you like to see these tours?
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(BBIBE) TZL® LD (Getting Started) | R IATIERBHIMITN—2 a2 4 ChR (ot BEFTRREING (L >TWET,
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MuseScore A fE>TW% ) HICHBAE U7 5. BIIRYR— F 2B2HENHY £7.
NIRRTy

N R Ty IIZToERTBIZIE

e MuseScore @I T 7HA biyR—F > N ETY s B DA Z1—Hb
e MuseScore 7O 5 LAV - 22S4 Ny KT B DA Z1—Hh b
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AVTFRE AT
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How To's
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"File attachments" # 7' 3 > AL £ 5,
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» How to write a good bug report: step-by-step instructions Isolate bug &' (MuseScore HowTo)

AR b=V

MuseScore (§ Windows, macOS, £ DLnuxT (X b 31— 3> @RHBBENDBSDAI B 4 BLELDARL —F A I RAFLIZRIGLTWET. Zh
54 ~T|4 MuseScore 87> O— R B R—SHSFBETE £7.

AR =L
VI IIITEREICO—RLIzh, ROARL—F 127 27 LRIDOFIERBIZ It > TEDH T &L,
Windows TDOA R b =)L
macOS TOA R =)k

Linux TOA R b =)k
Chromebook TDA >R b =)l

VIHBEEE
AR b=I)LE{T>1-1%. MuseScore ¥l TRIIAT % & . BEARNLRTRENHEBIZ DLW THEM IR RENET .
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Windows ThH-1 X b —JL

AR =L

Windows 10 TL 7z % MuseScore ¢ 32-bit /X—<> 5> A% Windows Store (ZHZEENTWT. 22 @ A7) w29 % ¥ Store app. 7 MuseScoreDX—HBHE *
T, ¢ Toettheapp> KRR %2 1) v o F 5127 T. MuseScore BX 7 O—FaNn, 1 >R F—ILEh. SIZGEWTEET v 75— A Thh T,

&%\ MuseScore DY T TH A DI O—F @ A—IH5 Windows 2R =5 —hF5NE 9. 64-bit H 32-bit HhARATX Y O— FAFAL £
Y. ERTDA =%y b TSV —DEDT7AINE XTI O—F T 200 HERERDTEET ., 7rrrafz&20 v LELLD.

Ky O=FHAETLIzn., ¥DT7ANEZTIVI v LTA VR —ILEBBDEL &) . 1EHDICHT=->T Windows D+ 1Y) 7 1 #iReH MR %KD 2
AR VERRLET, RnEZ )y LTHITLEL &,
tITBEACRM—ILFIENEE ) 7.

ﬁ MuseScore 3 Setup

Welcome to the MuseScore 3 Setup
Wizard

The Setup Wizard will install MuseScore 3 on your computer.
Click Next to continue or Cancel to exit the Setup Wizard.

=

ZIT. HDWIETH. cancel 57 1) vy G BHERDERRNIMNY) £9 .

ﬁ MuseScore 3 Setup

MuseScore 3 Setup Wizard was
interrupted

MuseScore 3 setup was interrupted. Your system has not
been modified. To install this program at a later time, please
run the installation again. Click the Finish button to exit the
Setup Wizard.

Next &2 1)y 0§ BEEUTL. £ b T v 77 14— K H'free software license D&HFERRL £7 .

ﬂ MuseScore 3 Setup —

X
End-User License Agreement )
Please read the following license agreement carefully rrU

A

MuseScore, free and open source music notation software.
ICopyright (C) 2002-201%2 Werner Schweer and others.

This program is free software: you can redistribute it
and/or modify it under the terms of the GNU Genesral Public
License wersion 2 as published by the Free Software
Foundation and reproduce below with the following
lexception:

- If you create a document which uses fonts included in

1 accept the terms in the License Agreement

Print Badk Cancel

ENSDEMBETH. FHATHRL -5 "l accept the terms in the License Agreement" (ZF = v Z A AN Next 52 V) w2 L T&ITET. WIZA R P—F—(F
MuseScore % {R7F 9 DIBHOMERAE KO TE £T .
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https://www.microsoft.com/store/p/musescore-2/9p0cnr9rwzsx
https://musescore.org/en/download

ﬂ MuseScore 3 Setup —

Destination Folder
Click Mext to install to the default folder or dick Change to choose another.

S «

Install MuseScore 3 to:

IC:\Program Files\MuseScore 3\

Change...

FL AR F—ILT B MuseScore ¥ FIFIZBEIZO Ea—RIZHBIBN—2a > bFoTHELWGEIZIE. DT ANE—IZEZ DN TEELT(E:
MuseScore 3 (& MuseScore 2 %> 1 A FEF % Z ¥ x C ARRIATICFIATE £9)
Next &2 1) LTHATLET.

‘ﬁ MuseScore 3 Setup -

x
~
Ready to install MuseScore 3 rrU

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

[

Install %30 L THATL 7,
Y FTY T A= P32~ 3R TREL T 71D P R F—ILERREETV. ROBEFRRE L) 7.

ﬁ MuseScore 3 Setup -

x
o)
Installing MuseScore 3 rTU

Pleage wait while the Setup Wizard installs MuseScore 3.

Status: Updating component registration
I E———

L TRERIC,
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ﬂ MuseScore 3 Setup

Completed the MuseScore 3 Setup
Wizard

Click the Finish button to exit the Setup Wizard.

Launch MuseScore 3

=

Finish 527 1)y L TA A M=F—=%8TL£9. KV A—FLEA VR —F—5HKRLTHLEVERA.
MuseScore &34 %
A Z 2—H 5 MuseScore A48 BIZ(F. R&— ~£THF0%5F i~ MuseScore 3 —MuseScore 3 & EU £ 7,
%2 —+—: Silent ] unattended > X k —JL
e XDV F&E) &, BEFRT S &7 MuseScore 51 >R b —ILT&FT.
msiexec /i MuseScore-X.Y.msi /gb-
ToARA =L

MuseScore 57> A > A P =—ILT BIZ(F. XZ21—HHRE—F>2LTHT OS5 L~ MuseScore 3 — MuseScore 5 7> > X b —)L;, & IRAHY . Windows' I b O—)L/NFR
WafEWET, PR F—ILLTHIEM L 72X 3 7% MuseScore MFREIFHIBRE N EFHA.

FITN AT AT

SRTLIZE o TinstallerA 7Y 2SN B Z EH BN H LN EEA. MuseScore &1 22 —ILT B EATERQWERIZIG, XV O—FLIz7 7MILER
gL, FTANTa—%5Yv o LT, bL "CHOZFTMIMBNDIE 21— LBELZ6DTT, ZDIAE2—RX—5RET B/, ZDT7
TUNDT 2 EX(E 70y 2 SHSHEMIH Y 9. " ERRSNIIFRIZIE, HFATEK'EFvIL, "K' &7y LThHBEI>A—FLIz7 741
WEaBEITL ) vo LET.

SR > o

* How to install MuseScore on Windows without administrator rights @ (MuseScore HowTo)
e How to run MuseScore as Administrator on Windows & (MuseScore HowTo)
e How to fix MuseScore installation error on Windows & (MuseScore HowTo)
e MSI command-line options &
» Standard installer command-line options &'
macOS ThH1{ > X b —JL
AR =L

DMG (T 4RI A A=) 77'()l/LiMusechre<7)'717“*7“'f FPDETO—RFR=J(IZHN) FF. macOSD!) >0 %01 v LTX I O0—FaERBLET.
K O—FATT L1zb, DMGT7 7 ILERTINI v I LTTARIAX—ChT I M LET.

‘eso® | MuseScore-3.0

® 2 items —_— —

MUSESCOore
o <

A ;

Applications MuseScore 3

MuseScored7 A A> & 77— a2 74IEDTAAIRZ v o7& Oy TLET,

If you are not logged in as administrator, macOS may ask for a password: clickauthenticate and enter your password to proceed.
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https://musescore.org/ja/node/11193
https://musescore.org/ja/node/16316
https://musescore.org/ja/node/67256
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@ Copying "MuseScore 3" to "Applications™
——— (<]

148,39 MB

When the application has finished copying, eject the disk image. You can now launch MuseScore from the Applications folder, Spotlight, or Launchpad.
Note: As of macOS 10.15 "Catalina”, the system has to be told to permit MuseScore to be allowed to access user parts of the file system. The first time you use it on
Catalina, it will ask you if you wish to permit it; of course, answer "yes", but if you bypass this by accident, you can set it via System Preferences > Security and

Privacy > Privacy > Files and Folders. Unlock with your Admin credentials, then navigate to MuseScore (whichever version(s) you have and want), add it or them to
the list of apps, and select "Documents” and "Downloads" folders, or as you prefer.
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D@ MApplication; 7 4L RIZAE—F B2 TOKTY ., &tz 77T =2 aDOBAH R BEBON—2a AR M—ILTH L bTARETTY .

Install on Linux

MuseScore packages for various Linux distros are available from thedownload & page. The easiest to install is the Applmage, which can be run on any Linux
distribution, but a range of other specialist packages are available if you prefer. Building from source ' is another possibility.

Applmage

Applmages ' can run on virtually any Linux distribution: all the files needed are contained within the Applmage itself, just like a portable App. The following procedure
allows you to run the MuseScore Applmage on your system:

Step 1: Download

Applmages come in different versions. Make sure you download the right one for your system. To check the architecture of your system:

1. Open the Terminal.
2. Type

arch

or

uname -m

The output will be something like "686", "x86_64" or "armv7":

e i686 (or similar) - 32-bit Intel/AMD processor (found on older machines).
o x86_64 (or similar) - 64-bit Intel/AMD processor (modern laptop and desktop computers, most Chromebooks).
e armv7 (or later) - ARM processor (phones & tablets, Raspberry Pi 2/3 running Ubuntu Mate, some Chromebooks, usually 32-bit at present).

Go to the download & page and find the Applmage that best matches your architecture. Once downloaded, the file will be named MuseScore-X.Y.z-$(arch).Appimage".
Step 2: Give the file permission to execute

There are two ways to do this:
From the File Manager:

1. Right-click on the Applmage and select "Properties”.

2. Open the "Permissions" tab.

3. Enable the option labelled "Allow executing file as a program”.
The process may be slightly different in other file managers.

From the Terminal:

This command works on all Linux systems (Note: The code below assumes that the Applmage is in the Downloads folder. If not the case then amend the file path
accordingly):
cd ~/Downloads

chmod u+x MuseScore*. Applmage

Step 3: Run the Applmage

e To run the program, just double-click it.

Note: You can move the Applmage to wherever it is most convenient. And to "uninstall” it, just delete it.
Install the Applmage

The above procedure allows you to run the MuseScore Applmage but doesn't integrate it with the rest of your system: it doesn't appear in your App menu, and
MuseScore files are neither associated with the program nor do they have the correct icon on them.

To remedy this, you need to actually install the program as follows:

1. Open the Terminal.
2. Type the following (Note: The code below assumes that the Applmage is in the Downloads folder. If not the case then amend the file path accordingly):

cd ~IDesktop
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.IMuseScore*.Applmage install

Or, alternatively, you can combine the operation into one command:

~Idesktop/MuseScore* Applmage install

Use the "--help" and "man" options to get more information about the available command line options:

IMuseScore*.Applmage --help # displays a complete list of command line options
IMuseScore*.Applmage man  # displays the manual page (explains what the options do)

Distribution Packages
Debian

(Ideally before, otherwise while or after) installing MuseScore itself, you can install one or more soundfont packages (if none is installed, the dependencies will pull in
a suitable soundfont automatically):

musescore-general-soundfont-small: the standard MuseScore_General soundfont in SF3 format, as shipped with MuseScore for other operating systems
musescore-general-soundfont: the MuseScore_General HQ soundfont in SF3 format, as available via the Extensions manager

musescore-general-soundfont-lossless: the MuseScore_General HQ soundfont in uncompressed SF2 format: takes up alot more space on your hard disc, but offers
the highest sound quality and extremely fast startup times

fluidr3mono-gm-soundfont: the old soundfont shipped with MuseScore 2.0 (antecessor of MuseScore_General), use only if resources are very tight or you need it
e timgmémb-soundfont: the old soundfont shipped with MuseScore 1.3; cannot substitute the others; use only if you need it; extremely tiny

Note: only the MuseScore_General soundfont (HQ or regular) supports single-note dynamics (SND), and you needat least version 0.1.6 of those soundfonts (from
unstable or backports) for SND support!

The command sudo update-alternatives --config MuseScore_General.sf3 can be used at any time to select the default soundfont used by MuseScore if you install more than one
(note timgmémb-soundfont cannot be selected here).

Then, install the musescore3 package for MuseScore 3.x (the current stable version) ormusescore for MuseScore 2.x (there’s alsomusescore-snapshot for the unstable
developer preview). The packages are available in the following distributions:

e musescore3: sid (unstable), bullseye (testing/Debian 11), buster-backports (stable/Debian 10), stretch-backports-sloppy (oldstable/Debian 9)
e musescore: buster (stable/Debian 10), stretch-backports (oldstable/Debian 9), jessie-backports-sloppy (oldoldstable/Debian 8)
e musescore-snapshot: experimental (usable on unstable)

See https://backports.debian.org/Instructions/ & for instructions on how to add an official Debian backports repository to your system and install packages from there.

Note: without the appropriate backports, older versions may be available: MuseScore 2.0.3 on stretch, MuseScore 1.3 on jessie. Using the latest 2.3.2 version for 2.x-
format scores instead (or conversion to 3.x) is strongly recommended!

Fedora

1. Import the GPG key:

su
rpm --import http:/lprereleases.musescore.orgllinux/FedoralRPM-GPG-KEY-Seve

2. Go to thedownload & page of the MuseScore website. Click on the link for the stable Fedora download and choose the correct rpm package for your
architecture.
3. Depending on your architecture, use one of the two sets of commands to install MuseScore
o for arch i386

su
yum localinstall musescore-X.Y-1.fc10.i386.rpm

o for arch x86_64

su
yum localinstall musescore-X.Y-1.fc10.x86_64.rpm

If you have difficulty with sound, see Fedora 11 and sound .
See also the hints for the various distributions on the download page &.

KDE neon 18.04 (bionic)

The KDE neon packages are built on a differentrepository & than the normal Ubuntu PPAs, as this is the only way for us to build packages for KDE neon. Due to
limitations of the OpenSuSE Buildservice used, this currently only provides amd64 (64-bit PC) packages, no ARM packages (Slimbook or Pinebook remix).

All commands listed below must be entered in a terminal, inone line each.

1. Remove the Ubuntu PPAs (all three of them) from your system if you've ever configured it before. This is generally inetc/apt/sources.list or one of the files below
letc/apt/sources.list.d/; if you used add-apt-repository (the recommended way) to enable the PPA, you can remove them with:sudo rm -f /etc/apt/sources.list.d/mscore-ubuntu-
ubuntu-mscore*

KDE neon is not compatible with the Ubuntu PPAS!

2. Install a few standard packages (usually they are already there, but just in case they aren’t) to be able to securely download the repository signature key:

sudo apt-get install wget ca-certificates

3. Download (via secure HTTPS connection) and install the repository signing key:

wget -O - https://download.opensuse.orgl/repositories/home:/mirabile:/mscore/bionic-neon/Release key | sudo apt-key add -

4. Enable the repository:

echo deb https:/ldownload.opensuse.org/repositories/home:/mirabile:/mscore/bionic-neon ./ | sudo tee /etclapt/sources.list.d/mscore.list

5. Make the new packages available:
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sudo apt-get update

Now, it's time to install one or more soundfont packages (ideally install the one you wantefore installing MuseScore):

musescore-general-soundfont-small: the standard MuseScore_General soundfont in SF3 format, as shipped with MuseScore for other operating systems
musescore-general-soundfont: the MuseScore_General HQ soundfont in SF3 format, as available via the Extensions manager

musescore-general-soundfont-lossless: the MuseScore_General HQ soundfont in uncompressed SF2 format: takes up alot more space on your hard disc, but offers
the highest sound quality and extremely fast startup times

fluidr3mono-gm-soundfont: the old soundfont shipped with MuseScore 2.0 (antecessor of MuseScore_General), use only if resources are very tight or you need it
e timgmémb-soundfont: the old soundfont shipped with MuseScore 1.3; cannot substitute the others; use only if you need it; extremely tiny

If you skip this step, a suitable soundfont will be automatically installed when you install MuseScore itself in the final step.

Note: only the MuseScore_General soundfont (HQ or regular) supports single-note dynamics (SND), and you needat least version 0.1.6 of those soundfonts (from
our repository) for SND support!

The command sudo update-alternatives --config MuseScore_General.sf3 can be used at any time to select the default soundfont used by MuseScore if you install more than one
(note timgmémb-soundfont cannot be selected here).

Finally, you can install the latest stable version of MuseScore withsudo apt-get install musescore3 and the old 2.x version withsudo apt-get install musescore (the musescore-
snapshot package with an instable developer preview is also available).

Ubuntu, Kubuntu, Xubuntu, ...

WARNING: these instructions are not for KDE neon users (see above)!

MuseScore 2.x (the old version) is available from 18.10 (cosmic) to 19.10 (eoan) out of the box. Older Ubuntu releases carry older versions (18.04 (bionic) has 2.1,
16.04 (xenial) has 2.0, 14.04 (trusty) and 12.04 (precise) have 1.3 and 1.2, respectively). Similar to the Debian instructions, we recommend using the latest 2.3.2
version for old 2.x scores instead, or migrating those scores to MuseScore 3.

Besides the versions supplied by the distribution itself, the MuseScore Debian packager provides newer versions of MuseScore for older Ubuntu releases in official
PPAs (package archives).

Please activate the Stable releases of MuseScore 3 & repository on your system and then install themusescore3 package, available for all releases from 18.04 (bionic)
onwards. (It is not feasible to provide MuseScore 3 for older Ubuntu releases, as those lack the minimum Qt version required by MuseScore 3.)

If you wish to install the older MuseScore 2, activate theStable releases of MuseScore 2 &' PPA and install the musescore package, available for 12.04 (precise), 14.04
(trusty), 16.04 (xenial), and 18.04 (bionic) onwards. (Some intermediate releases may have slightly older MuseScore versions still available, but it's best to update to
the next LTS.) On the ancient 12.04 (precise) and 14.04 (trusty) releases, this will upgrade the Qt library in your system, which may break unrelated software (and on
12.04 even the C++ libraries are upgraded), mind you; best to upgrade to a newer LTS.

There’s also aMuseScore Nightly Builds (unstable development builds) &' PPA, from which the daring can install themusescore-snapshot package, for LTS, that is, 18.04
(bionic) only.

WARNING: these PPAs are only suitable for Ubuntu/Kubuntu/Xubuntu/... butnot for Debian or KDE neon!

As with Debian, you can install one or more soundfont packages (ideally install the one you wantbefore installing MuseScore, but if you don't, a suitable one will be
installed alongside MuseScore):

musescore-general-soundfont-small: the standard MuseScore_General soundfont in SF3 format, as shipped with MuseScore for other operating systems
musescore-general-soundfont: the MuseScore_General HQ soundfont in SF3 format, as available via the Extensions manager

musescore-general-soundfont-lossless: the MuseScore_General HQ soundfont in uncompressed SF2 format: takes up alot more space on your hard disc, but offers
the highest sound quality and extremely fast startup times

fluidr3mono-gm-soundfont: the old soundfont shipped with MuseScore 2.0 (antecessor of MuseScore_General), use only if resources are very tight or you need it
® timgmémb-soundfont: the old soundfont shipped with MuseScore 1.3; cannot substitute the others; use only if you need it; extremely tiny

Note: only the MuseScore_General soundfont (HQ or regular) supports single-note dynamics (SND), and you needat least version 0.1.6 of those soundfonts
(possibly from the PPA) for SND support!

The command sudo update-alternatives --config MuseScore_General.sf3 can be used at any time to select the default soundfont used by MuseScore if you install more than one
(note timgmémb-soundfont cannot be selected here).

External links

e How to run the MuseScore Applmage on Linux@ (MuseScore HowTo, video)

Install on Chromebook
Desktop program

MuseScore's desktop program will work natively on Chrome OS's Linux machine called Crostini. Follow the steps described in the video:

. Install Linux Virtual Machine called Crostini. Go toSettings > Linux > Turn On
. Download Musescore Applmage package

. Configure Applmage to run. Setchmod +x for the Appimage file

. Run Applmage with / followed by the Musescore package file name

A WNBE

(4]

. Install required libraries if necessary, e.g.:

o sudo apt-get install libvorbisfile3
o sudo apt-get install libnss3

6. Install Applmage (using the install command line option) to avoid running it from Linux command line each time
7. Enjoy!
External links

e Watch this interactive video &' for more details
e How To How to run MuseScore on ChromeOS &' (MuseScore HowTo)
o For more detailed instructions that also provide better integration with ChromeOS, seelnstall MuseScore on Chromebook &
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2. BRANE— thxiTW)$éa FAOWAWN H—VILAT ABROZO—IZBNET. ZNHEEDZ TY.
3. ANLEWERSH DL %ﬁmﬁé%ﬁviiﬂﬁxzﬂ@
4. FFORENF—5E>TEADZKIZH—VILEBEIL £7. ZAOREDF—(FRATHNEBHT 2DIZFEWET.
.0#%9%W1tﬁﬁm%m%%ﬂ7vvbﬁ%ﬁAﬁ?éi¢Q@ﬁﬁ%kﬁ?écJ%W%EMLTWLiTA#bKUi%;ti?ﬁbﬁi: »T
9. 7ILARTABRETEIDIZEMTL &), LM NIZDWTETILT 7Za—X ) v o d—R—FE->Ten€tuo, 1, 12 & R17 i?
(E:ZORE XA 7AJISRESNTWS "JLy FO 5 BADBEEANNTHZ LI TEEHA. )
BIRLE-REOUFEANT BI2(E (2 302) 2L T &L,
6. BN EM ICEFEANT B (3. BEDERTIT) DX ERRIZATRETT

HEROMHE (TR) # 2R (e,

al

HENTABGE

1) 12— NI EBIAD/ S RZIZ DWW CRCREAITA £ 9.

o 75> T A B letters with prefixed slash-like strokes right under the tab body: i.e. 7th string: "a", 8th string: "/a", 9th string: "//a" and so on, all in the first
position below the tab body.

o £ 21 7R T A B:E numbers with 'ledger line'- like segment of string above the tab body: i.e. 7th string: "0" one position above the tab body with one ‘ledger
line'; 8th string: "0" two positions above the tab body with two 'ledger lines' and so on.

Ly PESOAAFA L Ea—&—F—Hh— FHA 5 121F1TA £ 9°: by moving the note entry cursor below (French) or above (ltalian) the tab body, 'shadow'
slashes or ledger lines will indicate the target stnng to which the fret mark will be applied; pressing one of the fret keys, will enter (and lay out) the note on that string.

YYREFEST

VIR EFESTT ABRUZERFAEANT BIZ(

o EHANE—FIZAY ., BFF - hBORIABUE 3 (FaL Z8B &), )

o ERAEANLIZVEZAES ) v o LET. BFEET 7Ly POICERENET (7 RARTABRETIEZ7L Y ha). ¥$NAEBIETRICIEF—R—FH bl
RBFER1TLET.

Alt+Shift+1 X2 Alt+Shift+1 2 {F>T 7L e SA&ERL $9.

BENEREEL . BIOER S ~ODANHLTEETT .

T EROMEE & TSR E 0,

B - REORS DBIR
T ABRHENEBANE—FTIE. ROEDFETHLER - AFORIARETE£7.
. %_hlgrl :\:;r:g?) ;Zg_ﬁjLﬁb‘bI{ﬁéﬁfki’Cmﬁé%uﬁE( NODF—R—FLa—thy MITAYE1—RDT T Y b 74— L+ —R— FEEIZIKE
* NumPad 1 ~ Numpad 9: 1289 EH /5 U EH § TORS HIE WFF —/ ¥y FH'd > Thumlock H' > DId
o BiEY A2 KD HIH B ERANY —N=OEM7 (A ET Y v s
o Q AR XIRL 2B MAVIE <7 l) . W TIERE () £7.
ERDMmE
TLv ESEER
BHANE—F T

o tDTL Y FRSOLEIZH—VIVEREL., BMFERA1TLABLET.
o AltShift+r X2 Alteshifte s A{FZ (I 7Ly PaCSAYBRTE £9. (BEICIHL. —BRVLTL Y MBER DL ). ZOEFESHEFNICEINET. )

BEE—F T
1. 7L raeSs iR L,
2. ROVWTIHDFIEEENET,
o BAEEZDHZ L E(BRT BIZF
o TEDHMATEAZEZLTLN/NERTL Y FEESIZT B IZ(FAShift+1 /1
HEONRE KA TOTIEREESNTVS "Iy OB 2 BADHEEANT D LI TE A,
ZNESHEEE
BEEEZTIZRDE~TL Y MIBEBENT 2123 (12120, 4DZAMERENTESTENERFEE) Z A TEDZDTHNUIE)
EFATE— FIZAY:
o H—=VILETL v Y= IZfuBEXH. cui+i /1 (Mac: cmd+1 /1) &3,
BEE— FIZ0 254

o —OHDIZWNIERDT Ly b7 —7 HIEY. ci+t /1 (Mac: Cmd+1 /1) A3H7,
e JLy bY—UEBDETLETIZNZ T 3,

0~y FOBF
Tl biEEAZORANY FIZEZBI21T:

1L BEHANE—FIZIEVRUKRET, 7L v MESHER L.
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https://musescore.org/ja/node/36056

2. shift#X AL, JORNY FDOF > - FT7HTEET.
F—R—FREDF &

EFANE—F

Type: to get:
1 roigateEF & L TER
! Tz tERF & L TER

Shift+1 to Shift+9 i 5 B4R (128FF T ~ LEFLER

gumpad HIONMPRL 4 SRR (12881 ~ MELEH)

Q BEDANE %NS T B
w BEDODANEfiE K& TS
0to9 7Ly bESEATN
AtoK 7Ly MBS EAN ( B Q)
Alt+Shift+1 BENTL v PESHEKRE
Alt+Shift+1 WENTL v baeSE/NE L
: (semicolon) KFDOAN
BEBEE—F
Type: to get:
0~0 ﬁ;ﬂ L=B® - (ko Bifi 2% F (12855% ~ UL E
Alt+Shift+1 BIRL =B OES % LTS (MuseScore A%5% % JEiR)
t PHEEZDZEE(CEEE LTS
Alt+Shift+1 BIRL-FFOES%E TS (MuseScore H%3% % JEiR)
' PHEEZDZEE(EEETITS

curi+r (Mac: cmd+1) B % [ U E& CLNDsZIZHE)
ctri+1 (Mac: cmd+.) FF 5 E U FE T FOZIZEE)
Shift+X JARNY KA - F7

SN o
o Video tutorial: MuseScore in Minutes: Lesson 7 - Tablature and Drum Notation@'
Yo FeBE
MuseScore (§ "& & BA" OMEER AL TWE T . ZOET. BEDOREL ERZNEHIRT 2 AR OWTHBAL £,
SNy o

e How to restore sound if playback stops working &

E7/0—IJ)LITF4X—
E7/O—ILIF 12— 5F->TERFEERICHEL . BEICODVLWTOWNTARLTE T,
E7/0—ILIF 1 x—%5F<

E7/0—ILI7 12— (PRE) #BA< (ZId. RATONEIEHI Y v L. RRENFzAZ =% "EF /O—IVIF (1 8—"%BUE¢. PREIZFZ)voL
fRERO/NIAFRENET . BRI PRE A#BILTUWBIRE, FRIHI2IZo U v o LIZERO/NBIZEDY £7.

= } o

Tl

e

EE Ex/-F070/F1...

- ERDIRE..
A

1111 i1
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https://www.youtube.com/watch?v=wnXLaZW9uA8
https://musescore.org/ja/node/96811

ﬁomam-,aﬁ:: = [mi x
- 2 <« O s o [l 2 3 4 PatPamo

D-Y)-000103220 f24  Subdiv{0 |2EF{1 |2 [AFSAFIE—{C maifA min = | ADLT4| AT~ [0 = EE a4 #2841 L 0 s EE{s0 |3

1 [ [t] 1 |2 1 P 0 I [ [ 1 |4 3 P " |8 i

e -

PRE (W S DA S aitaphnTuET.
—HLDINVAFLRR TELE (CRIEL . SREBET D EATEET. WMETPOLS— L RAIHMIZH) 7.

FREG EHFORLY 7 T, ERER-VmELY) TEEY. FE/ITO v TRRS N, BAWT Oy 7 FRAR TN TOLIERERL. KEan7Oy
ZIFBIRENTORVWERTYT (ChL0B(F 'RIEE" TEASZ A TEET) . £70v 73, EMCESSY . AAICIEER 4#RRTEDIRESIIA-T
WET., BR70v o0 A XOEBIZOWTUITO L= 3 OIETHAL £7.

ERRRTYTOEILGF—R—FHHET, tDF—R—FDF—452 1) v T2 tOEFOBET M LN TEET. YIRABEFHRET) 7
F—AR—FLIZBNG L. F—R—FDYDEEDF—ABETERRINEY. YIRERHENF—LIZHES DL XDERIIOLWTIDERIHBLNET. FTL
gzggﬁoné%ém\%ﬁm%&c%ﬁént%ﬁmF%A%%%mbivu%%CT@@v%%uvuTu\#—ﬁ—FmC%ﬁﬁmcuéiiicﬁ

BRRRTY TOLIZIE> TN —F— HH V) . ¢DORRTOBEDRBMNE . L—TRENL THNEDBELFRRLET.

PRED—FFIZELWFRIYT HHY £9. FERONOF 10 Hy [ 77 KA LEV S REFIIBESINIAMOT — KOMEAIRT 77 7127 >TL
FFT, LNLKRRTY FOECIEFAY TRV AZ2a—=m%H>T, KR - WELIZWT—RDXA T 5B ENTEET,

FEHF—ar
PRE mFAENEZEZAEEIW OHdh ) £9. —DBIF. BRERTV TOBIZH DRI O—IN—%21) v - RS IFTBHeNTEDRTT.
VIRARA —IVEEZE RDE ) ICBWW ) =L L) TEET,

e EHZ/O—)L. TIRKA—IL

o KFEZR & O—)L: shift +< ™ Rk —JL

o EHX—/:cul+< ™ RKRA —)L

o JKFEZX— L ctrl +shift +¥ ™ 2R —JL

BHEDNMBIZS Y > 795123, RATRRNIRL. REWMNIERDITET. ¥L T, ¢/MdizhEs ) v LTPREABEUET. PRE(ZD Y v L1z/IEl
HAEAFRIZHEDEHICZZO—ILLET.

BERERR

BRFRT 7T, %%‘75:—’)%7 o LTERETL. 2V wo TR FI T ENBEFEERT I HTEZT. ROL ) ICHBIF—EIBLAAS
X175, BRROHWALEEZLNET.
-%mﬁ%®§§§&ﬁtme\%mbTvtﬁﬁuﬁﬁﬁt@U\ﬁmLTv&#otﬁﬁﬁﬁméntﬁﬁt@U&70%ﬁ@%mmbﬁwva%t
LCHAT .

o cul BIRIZHDEFAEMZ £,
o culshit RN SFFEHIRL £ 7.

EROMmE

BRULAEFOTSEEADICIE BIRLIERFE L - TIZFZIL. HDWE - RENF—CESAEZ 2 B ERAEQICNZ L TURENDRA IV 0%
ABD WML, WEYR— I TUOEHA.

BIRL-BEF5HBT BC(d e F—5IHL £
BIRL -S4 OEBICBETSIZIE I7 1 2—DLZHEHEST. BEILE-WEEZ Y v oT 5,
BEWFEMZ B2

PRE TIZXN & 5 ICHBIF =2 LAS 2 ) v o2 TERABAT DI EATEET . ) Lo ARBEIRMETIE. BFEEET2HMEL T voL
TNEBEDEDE— NN TE— MREEWNET.

o ctl (DBROBMOEIRA. 7V v LENBICNAONES ., EREABATZICET28HZ. 27 TEREMAZ2OLEL T, SMliasZR -V

($. BN PRE [Z(F4 ) W12 RZUARRIT BN TWRE WD T, RATICR->TEIRL £9. ¢OBHICBRIZERHYH DHE. BEOEFH,ISBAT HEF
IZETHRA—2%&Y)RY) £3H. BEOEFERCHBNETCRLEMTHEHEICIE. BEECLTMASNET. S0 Z2ER IV R— I TH
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5Y. BRINET.

TrAILE) @RME F|R() BMA) Jr—TuHE)

hOB®

=

Y—IUTD)  FITLUE AL

100%

v | KA—ia— =

N[N d b Ny

o

o

ol

o shift ZDH 7 E—MRIZBIETZO—FA4RLE9. 6 LINE. BEOI—FICH-AESE4MZA FT. TRITNIARFLOT, BENMARFERCNEE
REDEFIZANEDLY 7.

o cultshit ¥DYTE—MRIZHDIA—FHL CIAFERLEFT. DA — NI TE-MRT2D2(ZHFIINET, DL ZIAEFIYR—FINTED
T, ERINET.

ERAAY P TR EWET DT

BEHARL P T RFLAVERRIY TTERTEET. BIREROSTARAY MFTRALEVST AR M F—REMET DIC(F. WEL-VERETRHER
RTYTTERLET. LT, YNICIBCHARE S ) v o L. LNLOERS ) v o LEREICECTRDY 9. Zox ) 7TEEOEFE—EL TSI Yy
g PR RSOTEETEET, TNTERCMBIZLARELBAICE. shit L1-2 £ K7L ET. BIRLEEBOHEDENEHDDT. OFTHD
BEMSEVIBICEET Wl e &M T.

LAWFRRTY PTRIR L TR BBROFETRRTEEY, BIZIE. NOLT(OF—R(FMEWHME (midi BADOFEIZIELT) LHEXHE CEBNEIZNT 24
Ty PELT) TRRTEET, INOALHBIICEIRRE-NIYNEZDZ LA TEET.

arra—JL
BN BEIZED > TROBREE > TWET;

147H

TZRY
BEOBEETICRL T

17

BEORELBRITLET.
MIDI f ZILR A F

MIDI A\Qk&EA> - A7 L E7.
BExRL

ZATDBENZRY £7.

3
BhaRE - FLELET.
N—TBE )

I TBEOBEAREL. L—TBEET Y A TLET.
R BE

BRLBEEAY - ATLET.

B4 0—)L

\ Eﬁ/ﬁ?’hti\ BAEF., BEMENTRIZHD L IBFRCRIO0-LLET.
PN =LA

X bR/ —LEAY - FTLET.

i

RFEFADOMEEL H ) FEA.
%S
Ij%?R LE-BEWAEE L-FRNCBEIL £7.
IN—

IN= P ENFTRENET .
%78
A=V
2% ERFRT) T TORIANEILHD/MHEERET 1 —F/Nv o LET.
|

ERFORTY T THE S HIZARIL 9. ¢ Z TORBIZ ¢ DA NEIT 2HTY . 44T THNIL, DFE "1" LT3 L8NFHENT ) v FRIZKY) . 9
B 2" B L 16 EFENT ) v FRIZRDEWS1RATYT. 7 78— TERAMA D5 ICHEINBETT.

Ty FR3HDRE AT TIIBNI W s, BT IRFARECTBITEIBMEND T Y FEHARZA DL IICKESX—L - 1T HILENDH D
NHLNELTA. EFEHETEIZLHTEET,

pL e

BEOY ZLMEEART L) Y FREMA £, BIZIE. EFOREL 3ISRET DL, HAN3DINITONET. HBEHETEIZ e bTEE
T BIRISERE 3ICLARE 1IZT 2. BEROMARIZ2DICATTRRSN, BIblanenElanEd.

EFTLUMORE L RS PRE TOFFARBAT 2V —HAENCLN £9. 7))y FRIEHDRIBELBR D ERRSNEWI enb, HEITIHT
HEREST DR BMENDT ) Y FENRADE ) X—LTBLELHINHLNELA.
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i -
il E Wave 1 2 3
= Stripe Pattern: | C maj/A min

101 g B

2T TINR—>
BURRTY TTEROESIZHBANTATNE—ERZ DN TEET ., REMEF Cmajor DEFRT/NA FA b LEITH. BIDADERRT 1 2
A pRTENTA N BENCEABZENTEES

O T4

%?%‘tgﬁ (TODNEFOHFIRTEET) ONASTAHFRRLET ., COEFORFARLET. " 7€y M H"I—H—RE" DELLATERDI

o A7ty b MiEE BICHSSRES TRESNIAD LT 1 I2OLToffy LTRVERbNET,
o O—H—3%E: WSS TOEICEIH ST, MIDHZESNBERETT . 0H5 127 DEIETH Y . 64 1N "KE L b ELH L bR LRR" TT,

A—H—REHNDA Tty bHDWMIEDOFE Y ) BEZ -, EINS RTFLEE I RBEICBTTEINET. haF->T, FIAFI—Y—EE—F
IZY)BEZ TMDIE N TREBE L 2BIZEEL. thh bt 7ty MY EZNIE, B8RS4 FEBX 352 ¢ahl) FHA. BEIZRLERBRT. 7
£y P TOBIFI—Y —RETHEEIZE) L) BEINFITH, EEEaNDZ v, %% BSESREE2EAH5 N TEET.

-,gj
BIRLI-BROSX EH 0 R—Th 4 E WS- UFERTRRLET.
" f{ﬁ&i‘ﬂ: FZ 7T higH-nEmeis) 39, BE METHZ LI TEZEFA.
RA L
BRDMHBE ) #EERICBEIL . BRAZAIWVEBZUI DA TEET. BOBEFCDBEFNENHKZ ) 2B, EOBETESEET. COERFD
R&(3 1000 DBETHIEL £9°. BIAIL1ES 250 (2T B & tDBFHOREID U4 HMEBENTEAH LT, )

=201
EDBFHEE L TR AREL "legato” DREAFAETIDITE) Z e A TEET, BENICLTHCE. SWRRYH— FORBREHASR ALY A &
DRECLTWCEE YL H—MIBEFT. tOBFFORE(L 1000 TRANFETH. tNEBAIBELTI 8 HTEFET, 950 (3 "LAH— b TEAHLY
YEZBNET.

F—R—F

INY AL DF—THEOHREEICRESNTWD DA H ) £7
o 1 BAEFEYT LICKE
o LEALFBERAXETICBE
o Del: BA - ERAHI
o Space: BAEDBHIAHZLE
HhARE<AX

PRE (JBIE— FXBEE— N TORREAN T, ZNHHE— FTOPREDRRDEAEZ -WIHE, REERENT NN AR T TRET2ZeAT&ET. PRE
IZB9E T 29 NTHTA/NT 1%, BIE— F(Z uilpianorollllight (2. BFE— K(Z ui/pianoroll/dark TIa£ V) £,

LHY—

IFY—EFE) & EERBIIESOTOERAY . TEVILIAY LY. BEROFTRNTEET.
IFY—%BAC

ROELLHADFHEEEST, IFY—%FRLET.

e F10 (Mac: in+F10) %484,
o XZa—hb FR- 1FY— HER,

IEY—(F. ToLZ v o8y oy BB (ZHH T T
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B

(V] 1= HEOH B E
& [1-KT MIDI
Fevl: ma ksueok[]  A=h[1 [2] Foual:[1 |3]
- .- =
wE: ltboc Expr. - | W=7 o ‘ . e LR H|
A IT = [0 :J
i 100 |3
@OI1-t
AV

ANy

[ -400048 |3/

+ 3 o8,

oy ZREITRICHY . IRR=T AL E KT IDAUHDSR-TWET . b7 v I7EBORREFE ST, FEROEBRBICESELTART D HTE

iT%N§;?—9%7UvﬁTh@%hﬁﬁﬁéhin\i@@%ﬂﬁﬁ?ﬁ%@%%\%ﬁxﬂy\UN—7\3—32@8¥$®N5X—ﬁ—%ﬁ$T6
ZedT .

MuseScore (F 2 AT DFEREFIZ"/N— b + FZvo"BENET. /X— b - FTVIE EOBRTEONZIMOEFTAIZIGL T, IBIC"Frorib FFvo"Ic
AHINTWET, BLDEB/EIF v oIV b TV a—DFEFBRE LEFTH. MDES, FIZENAF) QL0 T7)La - FLEA - EYyFA—FEWIREG
12, BEO Zfa TERHATE DL ). BEOF v o RILHABETY ., 4 LEBMOF v bZv 2, FZv 23> bO—ILDLEDOREGRE &2 1)y
0% %e. TR ERRTEET.

FrFI - f T EEETRNLTOET

VRER=IA

VAR (ZHNLEDOBEELETEL 3. FBTDIIE. AT X—DNFILES Yy I LTRZ 7930, TRy o AZEEEATILET.
F v > RIVRRKED

FX—b - bTvo D—FLIZ. REHPMFWIREAH) 2T, tnEo v IoTHEFroRIL- |‘5;‘/775{3?)1’L£f%f7)[5§£:51€ﬂ_? CERRT D OIVRA Y
FIZ>TWET, FroRIb - bT YT IZIEREVRZ (38 < CDBFRIZIZ/N— b - F T v IDEIERRENET.

fa—te&vno
LIV oOLCIIRAD YV OE) AR ERBD I 21— M AR DB, ¥NET )y I COBIEE L > - FTT B TR yFIT>T0E
To ENMLDDYVARKUAF IR DE, VAR RS> TWDB TV I EITHIBEINE T, VADT U THL RULTWRITIIE, TNTo/N— HE

EOWRRIZALNET. 32— MIZNEERFIOBEET., I2—FARVWTWS MY Z3BEINERA. 32— bEVONDRREAAEHLETELE. BE
DR HEBEI/ETEET.

N>

2= PRECOTICHDILATIVC, /oA ERIRDZENTEET . YDKATINEI YWY - FF77THE T/ DEEEADZENTEET,

iE: MuseScore [IRFZF v R0 b TV Fr L RIUHL T/ OBRELYR— L TEDT, /X—F - bV IIC@EL T VT - F v RO/ OE
HERENET. /N— b - TV IOSCOMEE TATO T ICABRICERSNET.

e
HE

h v oBBOTRICH DR T X—(3. BENTELFB £7. R .
JE: MuseScore [IKRIZF v RIL - b TV - FroRINIH L TEEDREE Y R—FLTEST. /X—b + IV ZIZIEEL TV - FroRIILOEEDE
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AERREINET. N—F - PIVIOFENEL, TNTOF ICEBRCERENET.

+Z v o DRI

FZ o TFEBOTFRMRY IR, EON—F - bTVIHDNIF PRI b TVIDEHLIRREINET.
BSR4

BRARARIEC(ZBIR L 72 b 5 v o ORRERNB A FRRSI N, tNAFET DN TEET,

£3 = MID1
Fouzi: @K KLy ol RIS Fourll: (6 |5

=7 0 &
e Grand Piano -

353 0 s
s 8 ; 100 |3 MEOIa-p

E:203

DTy OB BN— FDBRTYT ., /N— b - Ty IEF v RV b T IDEFIZED/N— F DEHRARREINET .
FE N FOBRIMETEZTH. IFY—TLRIBWTT. FroRINEHRIIMETE £EA.

Fr I
FroxI bV o EBIRT DB, (DF R b TV IDBHEHANZZIZRREINET .
FZLEy b

FDIS— A A OT A EB/LDH, FRBLONERLET. BEOXOT 4 —EHFIZ OV, ALEFENEEIRALFTATIA. FTLky FOFER. &
IZL R BEE R >TWET.

=3

Sy oNEREEETHIZE

LtDIZvoBo)yvod 5y, BlA BMEE & ICRkRENET.

2B Oy TRIC YR MNEs ) v o L, OEAEBEUET.

FR DOROY TR AZ2—TlE, tDORRTENLH I R T4 b AYR— T EITRTCOERIRREINET. BROY T F 74> bt
H—= [ZHRARFNTWRIGE, 2TOY I K742 b (SFZT774IL) DETHEBIY MY —IZBRESNIBICRRENET .

b2 MEROEFRERTICE. "R O—ERES Y v L. COEBOBRIINEXFARATLET. BEICHLTINAZ)ERLET.
&8

BEINDZEOLENEE

AT

tN— MZBERENB/
rIvoB

fSy AEBOBREEZ BIZ|
*I%@é@%%%?U/?LTt7— XLy MZAY, BAOEBEMZ £7.

N=F - TV IDBEEET D, BEBNICFO LT v N2 THRLAIZEDL) 7.

MIDI O fO—JL

—bEFrrR

#D/8— FHNRET D MIDIEATHOR— b EF v 2RI

Y= & aA—=32

MIDI D JN—T10—5 20E. ZDIERIE MIDI 731 RS HDTH->T. MuseScore [ZNBEIN TV B FOHEAIZIIBMEL £ A
L OEET

hEaH-oT, BEROFOFDELEINCI 2— TR A TEFT. SITEED/NN— P EOERERL VT, —FBLOTD 2" %33 -, ¢D/S— & 1
BrotkRoEH2AI 12— a7,

AR A R TR R

FHRBEN—F T ICBROR R VD% > VNS R=ALY DIV TWET, ¥DRE &7 v T2 e, FHMBREEN. ERTE 2WIHLLH) 9. €
NEBES Y v o DL, FMEEATTICIRY 7.

Eﬁ%§§§>XJT“O"i#ﬂ—umm:yhD—»%%ﬁ?%"t%:v?%Anét\i#ﬂ—%ﬁVttéc%®$5[%%3%6&5%@&%?6:&
AT .

RERFRTEAOEE (EFH— ., FEHR. 1Y)

HAEDERIT I FH—IZEBHROF v+ o RILHARREN, RATDFRFRTHENSOFIZEETE LS. HIZIE N1A1)> - EF Z-Fx 073 & DIZEZRTIED
DF v RIABN) RSN TWT, —2(F "7/La", KF"EFH—b" S5(C"MLEQ"TT. FF2oRy bTE, — B 12E" T, H)—(F "I a— "
W -RAETT.

ROFNAIZEBTEF H— b 52 HIFENHIT. ALFEIMNERELEZISNIERICHELLT.
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https://musescore.org/ja/print/book/export/html/details-area

L EFA-MILIEWES Y 3RO EFTEEY,

XL AZ =P B EM-TFR P -REETE2 L HBID. F—HR—Fa—bhy borkT AfF0NFETF,

Pz ERATLET. ZORRTOZOERTF R MIBICXFE L TRRINTWINA T, BEICHEL FHA.
EDBRTFRIERS ) Yo L #RFF2 bo70A7 1. &R,
VRERTFRIOTOANT A" EATAID "Fr o RIIVER R T T, EAZHBEDEEAT.

L RAY TR AZ =D EF - RV ET.

o hAwNE

@ E=75at070/(74 X

FourLOEE | MIDIPOVay | A9LU0RE | HROBRE

HESHEFrURILICIDL EOEHENNELS:

EAR Frull:

BB RN c-+ -
1 2 4 4 FIa -
1 2 4 4 FIa -
1 2 4 4 FIa -

0K Fruil

7.0Kk&Z 1)y LTRATIZRY £7.
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e How to change instrument sound (e.g. pizz., con sordino) midway through score@' (MuseScore HowTo)
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MuseScore TiZ Z NDEMTEBOEE & W) BN ZADTFA M EFATESDLHICLTVWET. ZOIFADTFRAMNIBR TFAIPETFRE
EIFERY), BEZY 2L TOWTHLWEZNDSRIZEELET.
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BROEFAEIT) &
o FDMEME, BEROZTAHIT-LERIEEINGE RN ) el HaEEL  FRS nEy.
o ENMBENEFZ. HLVERIIHTBIEL VEEOES ICHBINET. 120, Fr-AfSEFETNA 24BN HY 9. [FiL 23R
o ROBDFAIZ, Hitz s BRDBHHRRINET .

EREFEHMZS
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WETFAL RERE
EROEE
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e How to change instrument sound (e.g. pizz., con sordino) midway through score@' (MuseScore HowTo)
YO RT7 2 bESFZT AL
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MuseScore (3 2 DN 7 #—< v b DRIEEEE A R— P LTWET.

o B R4 b (sf2lsf3): 12D T 7AILT, 1 DU LD EEERHANBINTULET,
o SEZ(sfz): A —F 1 F EBERDT7 71 IWDMAEHE T, 1 OULNREESZ,<NEENTLET.

VAZRd e

MuseScore |23 B¢ GM General MIDI &) H77> K 7 + > | MuseScore_General.sf3 A\ BL T ). 128 5B X 2K, MRFTORBN S LI/S—H v 3
Y Ey bHASTUETS.

GM (General MIDI) (ZEBH)7 7 + —< v b T, MuseScore DIREY 7> K742 b & E> TEYICBET 2L HERS Mz 2 713, HAar-rBATZL—
Yy b TIZRMR=bpABETHY) . D1 —DaAL 1 —K—LTBETEET.

A2 2—%y FTlE. HDEDFEE. HDLDIEET. BRZYI 712 bASEELNET. BEDOY VL F 74> MIOWTERL 8B
[

YILFT7x2 DA b=

YO T7x b (FEL 2BR) # RO TRIRLIZE. thaX7ILo ) v LTH& £9. MuseScore (3t 7 7 A WERDY D F7 4> MZHISL T
WBDT, MuseScore SBIIAS N, €DYIL F 742 MY R =T 2ANEXATATTHRWTEET. RIZIFZEDY T2 F 742 07 71 ILEAIC
MuseScore ISMdT7 7' - =2 3 U ABIE[IT o TW2Hh b LT EHA. ¥DIHAIZIE. MuseScore T7 71 ILABIC Z 8 #BIRTE DA 1 —% KR D1
DIZ. 77ANERS ) Yo BRENBH) ET. ; _

WFNDIZEE. (DY T P74 A YR F—LE 2N EEWTL 2K/ TATHRRENID Yes" BT Uy oghlE, ¥DY I N7+ b - T 7
gg/l?usesco%:- 0)*7;]‘/ N7 bDTFA4L 2 P)IZaE—3nES, ZOFT 1L 7 bYHE IHE MuseSocre DIRFERE TRIZWEELIY TE EFTA. BED
SHZRDE) TT

o Windows: %HOMEPATH%\Documents\MuseScore3\Soundfonts

e macOS and Linux: ~/Documents/MuseScore3/Soundfonts

A—H=pBMLI=H T FT7x 2 b (3R, MuseScore (ZBL TOBMMRENY T F 742 MILRATL - TaL 2 PUICHEL. thhBKT 3
B, BBELTUIRY FBA YT ALI Y EBREDY T F 742 MIRDEY TY.

Windows x86 (32-bit) / MuseScore x86: %ProgramFiles%\MuseScore 3\sound\MuseScore_General.sf3
Windows x64 (64-bit) / MuseScore x86: %ProgramFiles(x86)%\MuseScore 3\sound\MuseScore_General.sf3

* Windows x64 (64-bit) / MuseScore x86_64:%ProgramFiles%\MuseScore 3\sound\MuseScore_General.sf3
e macOS: /Applications/MuseScore 3.app/Contents/Resources/sound/MuseScore_General.sf3
o Linux (Ubuntu): /usr/share/mscore-xxx/sounds/MuseScore_General.sf3 (with xxx being the MuseScore version)
ToAR b=V
YOI T P ET AR M=UT BITE 4D T RT3 bAA R P=LENTWD 7 2L —5F& . BIlRT 21217 TT.

SFZ

SFZFZL D7 7ANET ALY Y. SFZT 74l WAVRFLACRADKBDED 7 7 A WH BB AL>TWEY. SFZ 7 7AIVETFR M7 7ALT. &
DEDT 7AUHEZINEL EOREFOEDBEANEH TELN IO RHIN TV ET.

SFZDA >R =L
SFZ 7 74 (- FaL 28R X7 0—FL1zb., ¢tDSIFIZBTDLETDT 7AIL(SFZ 7 7AINELTOYT - FaL o M) AR DOF (Lo b Y~F
BCREETHRENHY ET. 7 - TALI M) EEORBIEENFFICLTHEET,

E:SFZT7 7AINDT7 A INZ—RNIZ WAV EBT 7L BB §DIHBEHDH ) . Libs & W) BOYTHRNK—DIEEHERTY. &7 00— KU1 SFZzip 7 7
I Libs 7L EAHBHBAITIE. ESFZHT - FrL o M JRICBBILEL L9,

96


https://musescore.org/ja/node/50196
http://en.wikipedia.org/wiki/General_MIDI

SFZDOT7 AR M=)
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%?§®N73>Eﬂ7>F7#7h%il&L:&bt@%\zztﬁiﬁ:tﬁ&ﬂt%%ﬁ%UiToEE#@M&ZZﬁZzzL@ﬁﬁﬂﬁéiéﬁ
SEL,

IEY—

IFEY—AHFAL BEROBOALAHEBIZEZ DN TE, 4NDRAIATEBERTHoTHHTRETY . BISFHAIE £ — 4 5B(f2a0,
KyrO— gy F7 74 ILDY R b

GM 4> K742 b

ATt F - 5477114 General MIDI (GM2) #RAE(ZHEHLL TUWVE S, 2 AR TIE 128 RABRR L ITRBOF R RGN E T,

e GeneralUser GS ' (29.8 MB uncompressed)
Courtesy of S. Christian Collins &'
Magic Sound Font, version 2.0 & (67.8 MB uncompressed)
Arachno SoundFont, version 1.0 &' (148MB uncompressed)
Courtesy of Maxime Abbey &
e MuseScore 1 came with TimGM6mb & (5.7 MB uncompressed)
License: GNU GPL, version 2
Courtesy of Tim Brechbill &'

e MuseScore 2 (up to version 2.1) comes withFluidR3Mono_GM.sf3 &' (13.8 MB).

e MuseScore 2 (as of version 2.2) and 3 come withMuseScore_General.sf3 7 (35.9 MB) (SF2 version & (208 MB)) [ERFE i & 1 £ 3 ([Changelog]x =SB 17 &
Uy, (ftpu//ftp.osuosl.org/pub/musescore/soundfont/MuseScore_General/MuseScor... &)

License: released under the MIT license &'
Courtesy of S. Christian Collins &'
MuseScore 3 on top offers an HQ version of that soundfont as an extension

Timbres of Heaven, version 3.2 ' (369 MB uncompressed)
Courtesy of Don Allen

A=TREZT IR TA b

e Sonatina Symphonic Orchestra (503 MB uncompressed)
Downloads: SoundFont & | SEZ format &
License: Creative Commons Sampling Plus 1.0
e Aegean Symphonic Orchestra &
Courtesy of Ziya Mete Demircan & (352 MB uncompressed)
e Soundfonts4U & (12MB up to 1GB, depending on which package you choose)
Collection of beautifully sounding acoustic guitars as well as pianos, basses, strings, harps and many more.

E7/ Y IR TH b
SF2ET/

» Acoustic grand piano, release 2016-08-04 &'
Description: Yamaha Disklavier Pro Grand Piano, sf2 format, 36MiB compressed, 113MiB uncompressed, 121 samples, 5 velocity layers
More information: http://freepats.zenvoid.org/ & including other soundfonts.
License: Creative Commons Attribution 3.0
Courtesy of Roberto Gordo Saez &

e Salamander C5 Light &
Courtesy of Ziya Mete Demircan & (24.5 MB uncompressed)

SFZE7/

e Salamander Grand Piano
Downloads: version 2 &' | version 3 &
Description: Yamaha C5, 48kHz, 24bit, 16 velocity layers, between 80 MB and 1.9 GB uncompressed
License: Creative Commons Attribution 3.0
Courtesy of Alexander Holm
o Detuned Piano & (244 MB uncompressed)
License: Creative Commons Attribution-ShareAlike 3.0
o Plucked Piano Strings &
Description: 44.1kHz, 16bit, stereo, 168 MB uncompressed
License: Creative Commons Attribution-ShareAlike 3.0
e The City Piano &'
Description: Baldwin Baby Grand, 4 velocity layers, 696 MB uncompressed
License: Public domain
Courtesy of Big Cat Instruments
o Kawai Upright Piano, release 2017-01-28 &
Description: 68 samples, 44KHz, 24bit, stereo, 2 velocity layers, 58MiB uncompressed
License: GNU General Public License version 3 or later, with a special exception &'
Courtesy of Gonzalo and Roberto

Kyo0—FLIzY 7> F7 71 IVORR

YOI T2 MET7AINYAZIDAREV EALERIND Z L HE . zip sfArk targz, i EDERERANIMEDNET. tNoDT7 71 ILEERT ZH1IC
fBIRT DDHELHY) T

o ZIP (IR EMEA T, B2 LOSTHR— IR TWET.

o STAtK (3T FT7 7ML EEMT HERTHESN TV ZT. BIRY S (Z(dPolyphone & (cross-platform software) A{F ) Ay, KDA > Z 1A > —ER%F|
AL 9. https:/icloudconvert.com/sfark-to-sf2 @

e .tar.gz (I Linux T\—ﬁﬁﬂﬁfgﬁzﬁ%iﬁ’cﬁ'o Windows 1 —H'—THN(I7-Zip @ #FHT 52 A TE. Mac 1—H—THh(LThe Unarchiver @ A, macOS
IZNBD T—hA7 - 2—F 4 )T« —%EWFET. 7-Zip 2EIB. —E GZiplZ, €N tar ¥ 2 EERT 2MBEHAHDRICBE(FZE L,
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https://www.polyphone-soundfonts.com/en
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e How to change the SoundFont or add another@ (MuseScore HowTo)
e The SEZ Format & (for details about the sfz specification)
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>t A H— (& MuseScore DENENAE I PO—ILL. KD EATRETT .

e MNERZA 77 ) aEHL T, FEBEIFAT S

o YN=TREML ENIR AT D

o BIKX L THFa—=0 5 TS

o ENEBAEEETS

o MIDIE&O FO—ILARIRL T, 27/ —FRA4F 30 R%{EH (version 3.1 PARE)
oA =D RIEIROE I a IR TIZHEPNTWET.
Fluid: SF2/SF3H 2> F 74> b BRFA 77— &fE5V T b T2 T7— - o (=TT,
Zerberus: SFZ 7 4+ —< v bDY L TIZA TS ) —hlfiot-YV 7 b T7— - YA —TF.
VRAR—IT 7 MZIWFIZ77 b 2 RAFIZERATHDICEVET.

Fa—Z U BERENF =27 5FRTIOICHENET.
KAF 2R (version 3L URE): o> I/ — b RKAFIJAMDI AL b O—F—5KETHDIHENET.

oY A P —REDRFITHAH
LG A =T 42 FODTICH BRR U (FROMAETT .

BEBICRE REDS VeI —REN LT 5 REFL METEREE LEJ. MuseScore #H< &> > wH AV —ICEBMICERaINET.
MEfEnFsiads RIBIZRFIN: BEERE > w1 — 2l & 7.

ZATIREREDS YA P —REN 2T H(DAIATDHZBAE LTHRELET.

ZATHLHBABEDAIAT DREE S A F—IZHHAAR LT,

7iﬂ)//tﬂ4ﬂ R ST F 74> e SFZ7 7 VDIE. T7 0 bE, v2&—Fa—=2 7. FRLEINET. @ —KHZB> Y
—REELIOOH T, WHOZ AT ARV TWSIAS, 1 DORATTHEIRIDS e —BEAE) ZLETEELA. ) YA —RED
%Ei tECZATICRE LBWRY . 2=F 1A 7 7 ~DIT Y ZKR— PETIEMIR ) FHA (LXETSR)., ToFa——2 7 6 25RO
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Fluid 8 7% 2 1) w042 SFASF3H I N 74> b FRFATZ ) —ICT7 IR TEET. T74I T, $72 F 772 | FluidR3Mono_GM.sf3 A\REIZHT
HFRAENTWBIETTT.
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Fluid | Zerberus IAS—IJ710F | Fa—-2¥  Y4F343
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. B DR A P

AJFICRFE | AAThroiEdAd BEECEE

BEIZIGL, YT R 74> b Dl H, BiRE, BISRHTTRETY . BETERNDY I K742~ (SFZ 7 7 IV AEH) LA EHEDZENTEET.
Fluid TOY 7> F7 4> bOXVNEIZ S £H— DX VIEOBREBEICRBMINFE T .

Y2 K7 4> b ORBAH
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Y2 K7 4> b OHIR

LtDY IR T7x2 b0 )y oL,
2. B RR %)y LET.

ZNUSEN S B A=A DtDY I N T2 MEBAINETHY IR T 52 b - THNE—DT AR =)L LIzhFTEH ) FHAD L. RIZH
BRLRATEET.
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Zerberus X 752 )y 0§ B ESFZEBY LTINS AT 5 =D F O—JLNRIVZT 7 2R TE 9 Fluid 2 7 L BBRDOFET, 7 7 LOEM, Bl %
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I7x7 b
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L Low RT60 Mid  HEDamping 20 25— 160 20k—] oy We

1% -
#

7 N /7 5 B3NV SR /7

000 |T 15me  |o 20me > 0048 |o 100 |5 1068 |5 00d8 |
RMS FRa2 Ui=2, LELME Leist T 42
ATFIEHE | ATPHEEHAS BERCHE [ BERORHDH |y

VXX—I 72 pZZital Reverb & SC4 Compressor
IV baFdr  AT7T BT
e IV FANTIT IO FBOBDO O Y TR - YR MHORELEVZT(T 7o MIA - BOIETEREINET).
I7 7 bDREDRE - TEHRHIZIE. oA =T RODTORZ L VN E T, I Lo A —E8F 5 TFB 230,

Zital Yy/N—77

Zital 27 LA - YN—TESa—ILEFEZIE NIREEHI S KR—ILEM E THEAEERMIZE) BT Z A TE £ . Pre-delay, reverbtime, reverb tone
FEIZ(IRDAY P O—ILEFEWET,

e Delay: ') /x—7 ) pre-delay % 20-100 ms &5 Tk E

e Low RT60 (Low frequency reverb time): 'L —D % & % {f > TIREIR THF R & 73 % BiF% % 50-1000 Hz S TREL £9°. 4D F A T DEBIKH
) reverb time %-1-8 secs &5 TR E

Mid RT60 (Mid-range reverb time): &K% reverb time % 1-8 secs # T3R3E) ‘

HF Damping: SEIEHA D) N—T7 578, ZOEEETEHY 47 - RA 2 PRABEES LAY . UN=T3 LB RAN ET.

EQ1: 40 Hz - 2 KHz T8RS BN % -15~+15 8 TH Y b - 7—X b

EQ2: 160 Hz - 10 KHz #38 N EE BH & -15~+158FThHY b - T—Z b

Output T7 7 FOEREAFHE, "Dry" (3RO, "Wet" (£1) /35— 100%, "Mix" (3 Dry/Wet ¥R A 50/50,

FEEQL X EQ2 (FBHMD ) /N—TDHZHEL. dry @E2>TL v al) ICIFERHATT .

;;I 7 M EBRAISERET BIC(F. "Output” % "Mix" (ZL . "Mid RT60" D& # & B YN—TEHICEREL £ 9. ¢, LICHALLT7 20 FOMFAEEL

scaarJLyy—
SC4XFLA4 AL TLyH—T. RBEDXAFTIv oL OaFRL, A oFBEOTEHRAEBOSTIEHATE Y. WBIXRDL HIZITWET.

e RMS:RMS (0) v ' —2 (D) BETIL 7Ly aafEL Y. MENHEICIE. ESOFHAL LB LarTLysat E—2 E—FTRE—
LAV Tar7yrarhBE g, X

TRy (15-400ms), FSHLEWMEEABATH ST v 3 hHEEY 2Nk

1J1) —2:(2-800 ms), {F5AL EMERME 7> ThHb A>Ty a v AR L% & TORHE

L &ULME (dB Bifz), 2T L v s A MBELIEHDESL L, LEWMEATIFD LI T v a MR e R DES(HEM,

L7 (L1 ~20:0), LEWMEEZBAASSICEAY 20> 7Ly atnR, Lodx bfpear7byiaigs)#g.

ST I A= R ST, DAL WY T MIT R, FI T Ly ar~ar Ty s a HOEEA L WEERH .

T ATy a e BT HEFENNS(RDBALDHBNT. ZDDEHTETET—A T 5.

RXOANIREET BIZ(E. RMS=1, L &ME=-20db, Lo F =6(2L. FEDBDEWHIL I 15 LT ET. ¢tk LB ->THEAZL 7.
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o Htz i BilEE YRR —F 21— T4 —ILRIZANL, Fa—z s0EERE AT v LET.
EQ) ZIOF1—Z 3 t0RRD £y a3 IlETERINE . ¢hE MuseScore TOT 7 #J)L b & Lizh) . $FENDR AT ORLEEE T 51 ci‘44t
YA —REDREEHAS & ZBB2EW, QFLWFa1—Z2 78> TWEIIRR— T B4F—F 147 74/ (WAV, MP3, OGG) (BT %(Z(
ITORR— B0, 2a77F7LET.
£4F 3 o X (version 3.1 BAf%)
RAFIORZTHD )y LT, OO/ — b RAF I ADER/ASRIVIZT 2 ERAL T,

S~ a
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o Curl+Shift+B (Mac: $+shift+B): Flat b.
o Ctrl+Shift+H (Mac: $+shift+H): Natural &.

o Ctrl+Shift+P (Mac: $+shift+P): Piano p (dynamic mark).

Ctrl+shift+F (Mac: $+shift+F): Forte f.

Ctrl+Shift+M (Mac: +Shift+M): Mezzo m.
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Ctrl+Shift+S (Mac: Cmd+shift+S): Sforzando s.

Ctrl+Shift+N (Mac: $8+shift+N): Niente n.
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o Ctrl+Alt+- (Mac: Cmd+Alt+-): Elision _.
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External links

e How to change instrument sound (e.g. pizz.. con sordino) midway through score@' (MuseScore HowTo)
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Ty —7# (# 50T, UKF —R— N TlEAI3)

o 77 kb (NIFD DY)

o BTN v —T x VNXFD"X) DN F#k (v — T % 27D)

o X7IVTZ bibb ((NLFD D" & 27D)
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TY. BEE-THONETT Y b, v —T0F F 215 LESEHHENTA S LE S IZ. MuseScore TIRIEL < BN EHA.
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E
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IWHBREEE L TEIENET.
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e HRARL RARAILTIE, A= FEESDORREHRAZ YA XTE, UEIO/N—2 3 > TER LRI T THRIATETT.
ARARZIA XLtz A= FRES AR T 7AIETDT7 A —ILRTREVET. "ZXRAIL" 7ALX—IZTFOREINTWS 7 7ML AIE—L TaEL T
2 b TEET. FHENREIRAC 74X —ICAEINTUWET. BL. ZOHMBEEERERTHZ L. BRITHhI->TIHW 217 71 ILHFIA
TEZHEINIFATH R R, TBE( a0
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BRHET, MuseScore (30— FRESICXFEAENE T, MOBMIFAE ) WHEDI—H —MIZ. MuseScore (DIXDARARMHL T ET,
o {Z#E: A Bb, B, C, C#,...
e KAVsE A Bb H,C,C4,..
e IRTKAVEEA B, H,C,Cis,..

e /)L 7 x—< a: Do, Do#, Reb, Re,...
o 75> R:E Do, Do#, Réb, Ré,...

BEXXF

Muge;_c;re DHEETIE. ANDALFNLFOVTNTH > THFLENETEANKEEBNIZAXFELET. TTH. BEFAXFT THORELERZ L
TEET.

o YA F—3—F&/NXFIT ¢, cm, cm7, ...

o R—ZFH/INXFIZ: Cle, ...

o T ~TKAXF: DO, RE, M, ...

FHEPRICKLFETEHEELLTA7IZTHIE HTE, t0IHA. ERFBEFBICAALIZEY 2R 7.
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Customize parts

Once you have generated a part (or all parts), you can select any part at the top and use the controls at the bottom to control not only what instrument is in the part,
but also which staves and voices within the instrument are included.
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Add instruments to a part

To add instruments to an existing part:

1. Select the part in the "Parts" pane.
2. Select the instrument from the "Instruments in score" pane.
3. Press + to add it to the "Instruments in part" pane.

Remove instruments from a part

To remove instruments from an existing part:

1. Select the part in the "Parts" pane.
2. Select the instrument from the “Instruments in part" pane.
3. Press - to remove the instrument.

Select staves for an instrument

To select the staves of an instrument to include in the part:

1. Select the part in the "Parts" pane.

2. Click the arrow next to the instrument in “Instruments in Part" to expand the listing to show all staves and voices of the instrument.
3. Select the staff to be removed.

4. Press - to remove it from the instrument.

Select voices for an instrument

1. Select the part in the "Parts" pane.
2. Click the arrow next to the instrument in "Instruments in Part" to expand the listing to show all staves and voices of the instrument.
3. Uncheck the voices to be removed.

Note: If you select only voice 1 for a given staff, then only the content in voice 1 for that staff will be included in the part. Thus, in order to share flute 1 & 2 on the
same staff, you will need to enter all notes onto both voices, even in passages where they share content. You also cannot enter the two parts as chords in the
passages where they share rhythms.
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Revert to factory settings

MuseScore has the option to revert back to the standard built-in presets or “factory-settings". This can be necessary if your settings are corruptedWarning:
Reverting to factory settings removes any changes you have made to the preferences, palettes, or window settings. This is not a commonly needed procedure;
consult the forums first, as there may be a way to solve your problem without resetting everything.

Via menu

If MuseScore still starts, it is possible to revert from within MuseScore.
Go to Help — Revert to Factory Settings. A warning dialog will appear:

This will reset all your preferences.

Custom palettes, custom shortcuts, and the list
of recent scores will be deleted. MuseScore will
restart with its default settings.

Reverting will not remove any scores from your
computer.

Are you sure you want to proceed?

Clicking Yes resets all MuseScore's settings as if the program was installed for the first time, and MuseScore will immediately restartNo will safely cancel the revert.
Via command line

If MuseScore does not start, you must run this process via thecommand line.

Instructions for Windows

. If you have MuseScore open, you need to close it first Eile — Quit)

: I:)I/IEE er;/‘\,/vizj to open the Run dialog. Alternatively select "Start" using your mouse and type "run," then click the "Run" program.

. Look for MuseScore3.exe on your computer. The location may vary depending on your installation, but it is probably something similar to My Computer — Local
Disk — Program Files — MuseScore 3 - bin - MuseScore3.exe

A WNPE

5. Click open to leave the Browse dialog and return to the Run dialog. The following text (or something similar) should display in the Run dialog
C:\Program Files\MuseScore 3\bin\MuseScore3.exe (actually %ProgramFiles%\MuseScore 3\bin\MuseScore3.exe)
For the 32-bit version of MuseScore in a 64-bit version of Windows, the location is
C:\Program Files (x86)\MuseScore 3\bin\MuseScore3.exe (actually %ProgramFiles(x86)%\MuseScore 3\bin\MuseScore3.exe)
For the Windows Store version (Windows 10), it is pretty well hidden, search for it via Windows Explorer
6. Click after the quote and add a space followed by a hyphen and a capital F:-F
7. Press oK
After a few seconds, MuseScore should start and all the settings reverted to "factory settings".
For advanced users, the main preference file is located at:

e C:\Users\[USERNAME]\AppData\Roaming\MuseScore\MuseScore3.ini
(actually %APPDATA%\MuseScore\MuseScore3.ini)

The other preferences (palettes, session, shortcuts, workspaces...) are in:
e C:\Users\[USERNAME]\AppData\Local\MuseScore\MuseScore3\ (actually %LOCALAPPDATA%\MuseScore\MuseScore3\)

For the Windows Store version (Windows 10), these are pretty well hidden, search for them via Windows Explorer
Instructions for MacOS

1. If you have MuseScore open, you need to quit the application first (luseScore — Quit)
2. Open Terminal (in Applications/Utilities, or via Spotlight search) and a session window should appear

3. Type (or copy/paste) the following command into your terminal line (include the '/ at the front):
/Applications/MuseScore\ 3.app/Contents/MacOS/mscore -F

This resets all MuseScore preferences to factory settings and immediately launches the MuseScore application. Note that you cannot quit the Terminal without quitting
MuseScore. You can safely quit MuseScore, quit the Terminal, and then reopen MuseScore in the normal fashion, ready to continue using.
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For advanced users, the main MuseScore preference file is located at-~/Library/Preferences/org. musescore.MuseScore3.plist.
The other preferences (palettes, session, shortcuts, workspaces...) are in ~/Library/Application\ Support/MuseScore/MuseScore3/.

Instructions for Linux

The following is true for Ubuntu, and most likely all other Linux distributions and UNIX-style operating systems.

1. If you have MuseScore open, you need to quit the application first €ile — Quit)
2. From the Ubuntu main menu, choose Applications — Accessories — Terminal. A Terminal session window should appear

3. Type, (or copy/paste) the following command into your terminal line Ctrl+Shift+V to paste in Terminal):
mscore -F

Or, if you are using the Applmage version, you must first use thecd command to change directory to wherever you saved the Applmage. For example, if you
saved it to your Desktop (and there is only one):

cd ~/Desktop
./MuseScore* Applmage -F

This resets all MuseScore preferences to factory settings and immediately launches the MuseScore application. You can now quit Terminal, and continue using
MuseScore.

For advanced users, the main MuseScore preference file is located at${XDG_CONFIG_HOME:-~/.config{/MuseScore/MuseScore3.ini.
The other preferences (palettes, session, shortcuts, workspaces, ...) are in ${xDG_DATA_HOME:-~/.local/share}/MuseScore/MuseScore3/.

See also
¢ Command line options
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Command line options

MSCORE(1)—General Commands Manual Page

NAME

mscore, MuseScore3—MuseScore 3 sheet music editor
SYNOPSIS

You can launch MuseScore from the command line by typing

e mscore [options] [filename ...] (Mac and Linux/BSD/Unix)
o musescore [options] [filename ...] (Linux/BSD/Unix)
e MuseScore3.exe [options] [filename ...] (Windows)

[options] and [filename] are optional. For this to work the MuseScore executable must be insPATH% (Windows) resp. $PATH (Mac and Linux). If it is not, see Revert to
factory settings for detailed instructions on how and where to find and execute the MuseScore executable from the command line on the various supported platforms.

A more detailed synopsis follows:

mscore [-deFfhliLmnOPRstvw]
[-a | --use-audio driver]

b | --bitrate bitrate]

¢ | --config-folder pathname]
| --monitor-resolution DP/]
| --debug]

| --install-extension extension file]
| --experimental]

| --factory-settings]
--force]

| -2 | --help]
--dump-midi-in]
--load-icons]

--job file.json]

| --layout-debug]

| --midi-operations file]

| --no-midi]

| --new-score]

| --dump-midi-out]

| --export-to file]

| --export-score-parts]

| --plugin name]

| --revert-settings]

| --image-resolution DP/]
S | --style style]

s | --no-synthesizer]

T | --trim-image margin]

t | --test-mode]

[-v | --version]

[-w | --no-webview]

[-x | --gui-scaling factor]
[--diff]

[--long-version]
[--no-fallback-font]

[-

-

f

d
e
]

0

&
[
[-D
R
[-E
[
[-F
[
[-h
-]
[
[
[-L
[-M
[F-m
[-n
[0
[
[-P
[-p
[R
[-r
[

[

B

[

-raw-diff]

-run-test-script]
[--score-media]
[--score-meta]
[--score-highlight-config]
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[--score-mp3]
[--score-parts]
[--score-parts-pdf]
[--score-transpose]
[--source-update]
[--template-mode]
[file ...]

DESCRIPTION

MuseScore is a Free and Open Source WYSIWYG cross-platform multi-lingual music composition and notation software, released under the GNU General Public
Licence (GPLv2).

Running mscore without any extra options launches the full graphical MuseScore program and opens any files specified on the command line.
The options are as follows:
-a | --use-audio driver
Use audio driver: one ofjack, alsa, portaudio, pulse
-b | --bitrate bitrate
Set MP3 output bitrate in kbit/s
-c | --config-folder pathname
Override configuration and settings directory
-D | --monitor-resolution DP/
Specify monitor resolution (override autodetection)
-d | --debug
Start MuseScore in debug mode
-E | --install-extension extension file
Install an extension file; soundfonts are loaded by default unless-e is also specified
-e | --experimental
Enable experimental features, such as layers
-F | --factory-settings

Use only the standard built-in presets (“factory settings”) and delete user preferences; compare with theR option (see also Revert to factory settings)

-f | --force
Ignore score corruption and version mismatch warnings in “converter mode”
-h |-? | --help
Display an overview of invocation instructions (doesn’'t work on Windows)
-1 | --dump-midi-in
Display all MIDI input on the console
-i | -load-icons
Load icons from the filesystem; useful if you want to edit the MuseScore icons and preview the changes
-j | --job file.json
Process a conversion job (see EXAMPLES below)
-L | --layout-debug
Start MuseScore in layout debug mode
-M | --midi-operations file
Specify MIDI import operations file (see EXAMPLES below)
-m | --no-midi
Disable MIDI input
-n | --new-score
Start with the New Score wizard regardless whether it's enabled or disabled in the user preferences
-0 | --dump-midi-out
Display all MIDI output on the console
-0 | --export-to file

Export the given (or currently opened) file to the specified outputfile. The file type depends on the extension of the filename given. This option switches to
“converter mode” and avoids the graphical user interface.

-P | --export-score-parts

When converting to PDF with the-o option, append each part’s pages to the created PDF file. If the score has no parts, all default parts will temporarily be
generated automatically.

-p | --plugin name

Execute the named plugin
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-R | --revert-settings
Use only the standard built-in presets (“factory settings”) but do not delete user preferences; compare with theF option
-r | --image-resolution DP/

Set image resolution for conversion to PNG files. Default: 300 DPI (actually, the value of “Resolution” of the PNG option group in thé&xport tab of the
preferences)

-S | --style style

Load a style file first; useful for use with the-o option
-s | --no-synthesizer

Disable the integrated software synthesizer
-T | --trim-image margin

Trim exported PNG and SVG images to remove whitespace surrounding the score. The specifiedmargin, in pixels, will be retained (useo for a tightly cropped
image). When exporting to SVG, this option only works with single-page scores.

-t | --test-mode

Set test mode flag for all files, includes --template-mode
-v | --version

Display the name and version of the application without starting the graphical user interface (doesn’t work on Windows)
-W | --no-webview

Disable the web view component in the Start Center
-X | --gui-scaling factor

Scale the score display and other GUI elements by the specifiedfactor; intended for use with high-resolution displays
--diff

Print a conditioned diff between the given scores
--long-version

Display the full name, version and git revision of the application without starting the graphical user interface (doesn’t work on Windows)
--no-fallback-font

Don't use Bravura as fallback musical font
--raw-diff

Print a raw diff between the given scores
--run-test-script

Run script tests listed in the command line arguments
--score-media

Export all media (except MP3) for a given score as a single JSON document to stdout
--highlight-config

Set highlight to svg, generated from a given score
--score-meta

Export score metadata to JSON document and print it to stdout
--score-mp3

Generate an MP3 for the given score and export it as a single JSON document to stdout
--score-parts

Generate parts data for the given score and save them to separate mscz files
--score-parts-pdf

Generate parts data for the given score and export it as a single JSON document to stdout
--score-transpose

Transpose the given score and export the data to a single JSON file, print it to stdout
--source-update

Update the source in the given score
--template-mode

Save files in template mode (e.g. without page sizes)

MuseScore also supports the automatic Qt command line options .

Batch conversion job JSON format

The argument to the -j option must be the pathname of a file comprised of a valid JSON document honoring the following specification:

e The top-level element must be a JSONArray, which may be empty.
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e Each array element must be a JSONObject with the following keys:

o

in: Value is the name of the input file (score to convert), as JSONString.

plugin: Value is the filename of a plugin (with the.qmi extension), which will be read from either the global or per-user plugin path and executed before the
conversion output happens, as JSONString. Optional, but at least one of plugin and out must be given.

o out: Value is the conversion output target, as defined below. Optional, but at least one oplugin and out must be given.

)

e The conversion output target may be a filename (with extension, which decided the format to convert to), as JSONString.

e The conversion output target may be a JSONArray of filenames as JSONString, as above, which will cause the score to be written to multiple output files (in
multiple output formats) sequentially, without being closed, re-opened and re-processed in between.

o If the conversion output target is a JSONArray, one or more of its elements may also be, each, a JSONArray of two JSONStrings (called first and second half in
the following description). This will cause part extraction: for each such two-tuple, all extant parts of the score will be saved individually, with filenames being
composed by concatenating the first half, the name (title) of the part, and the second half. The resulting string must be a valid filename (with extension,
determining the output format). If a score has no parts (excerpts) defined, this will be silently ignored without error.

¢ Valid file extensions for output are:

flac
Free Lossless Audio Codec (compressed audio)
metajson
various score metadata (JSON)
mid
standard MIDI file
midi
standard MIDI file
mlog
internal file sanity check log (JSON)
mp3
MPEG Layer Il (lossy compressed audio)
mpos
measure positions (XML)
mscx
uncompressed MuseScore file
mscz
compressed MuseScore file
musicxml
uncompressed MusicXML file

mx|
compressed MusicXML file
0gg
OGG Vorbis (lossy compressed audio)
pdf
portable document file (print)
png

portable network graphics (image)—Individual files, one per score page, with a hyphen-minus followed by the page number placed before the file
extension, will be generated.
spos
segment positions (XML)
svg
scalable vector graphics (image)

RIFF Waveform (uncompressed audio)
xml

uncompressed MusicXML file

See below for an example.
ENVIRONMENT

SKIP_LIBJACK

Set this (the value does not matter) to skip initialization of the JACK Audio Connection Kit library, in case it causes trouble.
XDG_CONFIG_HOME

User configuration location; defaults to ~/.config if unset.
XDG_DATA_HOME

User data location; defaults to ~/.local/share if unset.

Note that MuseScore also supports the normal Qt environment variables such asQT_QPA_GENERIC_PLUGINS, QT_QPA_PLATFORM, QT_QPA_PLATFORMTHEME,
QT_QPA_PLATFORM_PLUGIN_PATH, QT_STYLE_OVERRIDE, DISPLAY, €etc.

FILES

lusr/share/mscore-3.0/ contains the application support data (demos, instruments, localization, system-wide plugins, soundfonts, styles, chords, templates and
wallpapers). In the Debian packages, system-wide soundfonts are installed into /usr/share/sounds/sf2/, /usrishare/sounds/sf3/ OF /usr/share/sounds/sfz/, respectively, instead.

The per-user data (extensions, plugins, soundfonts, styles, templates) and files (images, scores) are normally installed into subdirectories under/MuseScore3/ but may
be changed in the configuration. Note that snapshot, alpha and beta versions use MuseScore3Development instead of MuseScore3 in all of these paths.

$XDG_CONFIG_HOME/MuseScore/MuseScore3.ini contains the user preferences, list of recently used files and their locations, window sizes and positions, etc. See above for
development version paths.

$XDG_DATA_HOME/data/MuseScore/MuseScore3/ contains updated localization files downloaded from within the program, plugin information, cached scores, credentials for
the musescore.com community site, session information, synthesizer settings, custom key and time signatures and shortcuts. See above for development version
paths.

EXAMPLES

Convert a score to PDF from the command line

mscore -0 ‘My Score.pdf' 'My Score.mscz'

Run a batch job converting multiple documents

mscore -j job.json

This requires the filejob.json in the current working directory to have content similar to the following:
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"in": "Reunion.mscz",
"out": "Reunion-coloured.pdf",
“plugin”: "colornotes.qml*

"in": "Reunion.mscz",

"out": [
"Reunion.pdf",
[ "Reunion (part for ", ").pdf" ],
"Reunion.musicxml”,
“"Reunion.mid"

": "Piece with excerpts.mscz",

"out": [
"Piece with excerpts (Partitura).pdf",
[ "Piece with excerpts (part for *, ").pdf" ],
"Piece with excerpts.mid"

}
1

The last part of the job would, for example, cause files like Piece with excerpts (part for Violin).pdf” to be generated alongside the conductor’s partitura and a MIDI file with
the full orchestra sound, whereas the equivalent part of the Reunion conversion will be silently ignored (because the Reunion piece (a MuseScore demo) has no
excerpts defined).

MIDI import operations

The attached midi_import_options.xml ' is a sample MIDI import operations file for the-M option.
DIAGNOSTICS

The mscore utility exits 0 on success, and >0 if an error occurs.

SEE ALSO

fluidsynth(1), midicsv(1), timidity(1), qtoptions(7)

https://musescore.org/handbook @&

Online Handbook, full user manual

https://musescore.org/forum @

Support Forum

https://musescore.org/en/node/278582

Reverting to factory settings (troubleshooting)

https://musescore.org/project/issues &

Project Issue Tracker—Please check first to if the bug you're encountering has already been reported. If you just need help with something, then please use the
support forum & instead.

http://doc.qt.io/qt-5/qguiapplication. html#supported-command-line-optio... &'
Documentation of automatic Qt command line options
STANDARDS

MuseScore attempts to implement the following standards:

e MusicXML 3.1 (score interchange format)

e SF2 (SoundFont 2.01)

e SF3 (SoundFont with OGG Vorbis-compressed samples)

e SFZ (Sforzato soundfont)

e SMuFL (Standard Music Font Layout 1.20)
HISTORY
MuseScore was split off the MusE sequencer in 2002 and has since become the foremost Open Source notation software.
AUTHORS

MuseScore is developed by MuseScore BVBA and others.

This manual page was written bymirabilos <tg@debian.org Z*>.
CAVEATS

The automatic Qt command line options are removed from the argument vector before the application has a chance at option processing; this means that an
invocation like mscore -S -reverse has no chance at working because the-reverse is removed by Qt first.

BUGS

e MuseScore does not honor /etc/papersize.
e Probably some more; check the project’s bug tracker (cf. SEE ALSO).

MuseScore—January 12, 2021
New features in MuseScore 3.6
New score setup and layout features

MuseScore 3.6 introduces a new music font, Leland, a new default text font, Edwin (a version of New Century Schoolbook), and many new default settings. It also
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introduces a number of new features which are available in all newly-created scores by default, and which can also be applied automatically or manually to existing
scores.

The three main features, which are interrelated, are:

¢ Automatic instrument ordering
e Automatic brackets and braces
¢ Vertical justification of staves

The first two features apply at score creation time and are available in the New Score Wizard, though they can also be accessed later in the Instruments panel.
Previously, it was up to the user to arrange instruments and add brackets manually once the score was created. The aim of these new features is to save time and
give a better default result in the majority of cases, but it is not intended to accommodate every possible score setup. For unusual layouts, the results can be
customised after the score is created, the features can be turned off completely, or a template could be used.

Automatic instrument ordering

@ New Score Wizard

X
Create New Score i~
Choose instruments on the left to add to instrument list on the nght: r I |

Ordesing: | Orchestral v
Common - i Add Sta A

Woodwinds Staves Visible Clef Linked Stave type
Free Reed

Brass

Percussion - Pitched

pitched

Keybaards
Strings - Plucked
Strings - Bowed

-v---vv-
=

< Back ext Fini Cancel

When creating a new score via ‘Choose Instruments’, there is now an 'Ordering’ dropdown showing the current system of instrument ordering. ‘Orchestral’ is the
default. As instruments are added to the score, they will be added in the correct position according to the select ordering. (Previously, each instrument would appear
below whichever was currently selected in the right-hand list.) This also makes it easy to, for instance, add a double wind section, by selecting Flute, Oboe, Clarinet
and Bassoon in the left-hand list, and clicking 'Add to score' twice.

Each ordering defines a position in the score for solo instruments. For example, in an orchestral ordering, this is above the strings. With an instrument selected in the
right-hand list, the 'Make soloist' button will move it to that position. You can designate multiple soloists; within the soloist 'section’ the overall ordering will apply. Solo
instruments will have "solo" added to their name by default, and will be numbered separately from non-solo instruments, where relevant. Note that the soloist
designation is a score layout feature only and has no impact on playback.

One quirk is that, for now, only a single soloist position is defined per ordering, so a work with a chorus plus both vocaénd instrumental soloists will place the
instrumental soloists above the chorus. These will need to be moved manually.

As before, instruments can be moved up and down manually with the buttons that are now to the right of the list. In the dropdown the ordering will have '(Customised)’
appended to its name. The customised ordering is saved with the score. You can reset the order by selecting the original ordering (or a different one) from the
dropdown.

Selecting the 'Custom’ ordering disables this feature entirely, as well as the automatic bracketing.
Automatic brackets and braces

The predefined ordering assigns instrument families (flutes, oboes, clarinets, etc.) and arranges those families intosections (woodwind, brass, percussion, etc.).
Brackets are added automatically according to these simple rules:

¢ A heavy bracket is applied to all adjacent instruments of the same section, assuming there is more than one
¢ a thin square bracket is applied to all adjacent identical instruments (four horns, for example)
e acurly brace is applied to each single instrument which is notated on more than one stave (piano and harp, most commonly)

Again, while this should provide reasonable defaults for most scores, it won't give perfect results for every possible style or layout. Fortunately, it is easy to make
adjustments once the score is created.

Vertical justification of staves

There is a new algorithm for vertically justifying staves to properly fill the page, which is turned on by default for new scores in MuseScore 3.6. To turn this off, untick
Format > Style > Page > Enable vertical justification of staves.
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< | Reset All Styles to Default OK Cancel

The basic principle of the algorithm is to try to make the space between staves equal, subject to two settings (all in Format > Style > Page):

e The space either side of a system may be increased proportionally by adjusting the "Factor for distance above/below bracket" setting to a value greater than 1.
For example, if this is set to 1.5, the algorithm will attempt to make the space either side of a bracket 1.5 times the 'standard' space used elsewhere.
e The same thing can be applied to braces with the "Factor for distance above/below brace" setting.

The space between a brace and bracket will be determined by the larger of these two values. The "Max. great staff distance" setting is used to limit the amount of
distance between staves joined by a curly brace. This is useful as these staves generally need to be read at once in a single glance by the player.

The "Max. system distance" and "Max. stave distance" should have reasonably large values to enable the routine to fill even quite sparse pages. Sometimes a page
will not have enough staves for it to make sense to justify. In this case, once the algorithm first equalises the space as described above, it then adds extra space
between the staves up to a maximum of the setting given in "Max. page fill distance" (multiplied by any relevant factor setting). If you find many pages are not fully
justified, but you'd like them to be, try adjusting this setting. In general, a low value is likely to be best for a score with a small number of staves per system, and a
larger one for larger numbers of staves.

The vertical justification is dynamic, and not tied to the section assignments of instruments used to determine the score order at the setup stage, so if you add or
remove brackets the spacing will change accordingly. In the same way, if empty staves are hidden on a given system, the spacing will be determined only by the
brackets which are present on that system.

Hopefully the default settings give good results in most cases, but it might take a bit of experimentation with the settings depending on the makeup of a score. If you
are used to using spacers to achieve similar results, it is best to try to find settings which give a good result for the majority of the score, and use spacers only where
local adjustments are necessary. It is planned for future versions to make this more configurable. For example, extra space could be suppressed for a specific
bracket, or the value might be increased or decreased for a particular page or system.

Indentation of first systems
This new option, which is turned on by default, is found in Style > Score > Enable indentation on first system. As the name suggests, it will indent the first system of a
section in the customary way for classical scores. (The old workaround of using a frame for this is no longer necessary.) If there are instrument labels present, the

maximum of either the value given for this setting or the length of the labels will apply.

Applying new features to existing scores

When opening an old score, a dialog box gives the option to apply either the new notation font Leland, or the new text font Edwin, or both. Each of these applies a
subset of the new default 3.6 style settings beyond just the font changes, for example, line widths and text sizes, but does not apply every one of the the new defaults,
in the interest of minimising disruptive layout changes.

i MuseScore3Development

Would you like to try our improved score style?

MabBig poco rit.

p leicht —— I

Our new professional notation font

Our improved text font

Since this file was created in MuseScore 3 4.2, some layout changes may occur.

Remember my choice and don't ask again

Keep old style
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To apply all of the new defaults, including these text and notation font changes, open the Format > Style window and click the "Reset All Styles to Default" button at
the bottom. This was formerly the Format > Reset Style menu option. The button behaves the same way, except that it no longer resets the page layout options which
are set in the Format > Page Settings window; that window now has its own equivalent button, which will reset only those settings it contains. This means that the new
style options can be tried out without completely ruining the layout of the score, though a few settings in the Score and Page settings of the Style window may need to
be re-set manually.

If it is an option, delete any non-essential system and page breaks, then select the whole score and select Format > Stretch > Reset Layout Stretch. Also delete
spacers if you want to see the default results of the new vertical justification algorithm (see below).

Edwin has wider character sizes in general than FreeSerif (though slightly smaller default point sizes are used) so it is quite likely that the Edwin option will cause
layout changes, particularly in scores with lyrics. Leland will affect the spacing less radically, but some adjustments may still be necessary.

Text items which have local style overrides applied will not have those customisations removed, either as part of the score migration process, or via the Reset Styles
options. This may result in an inconsistent score where some text retains its old font face or size. The new menu option Format > Reset Text Style Overrides will
remove these customisations, resetting all text items to match the currently defined text styles. (This is equivalent to clicking 'Reset to style default' for each attribute
in the Text area of the Inspector.) Note that this does not remove Custom Formatting, which must be done manually if required.

Applying new automatic instrument ordering and bracketing

Press | to open the Instruments panel, or choose the Edit > Instruments menu item. Assuming the score was created pre-3.6, the selected ordering will be 'Custom’. If
you wish to apply a standard ordering, select one from the menu, for example 'Orchestral’. The instruments in the score will be reordered according to that definition,
and have brackets and braces applied accordingly. Note that any existing brackets and braces will be deleted.

Applying vertical justification of staves

If you want to use this feature but have previously been using spacers to create extra or fixed distance between staves, it would be best to delete all those spacers
first, as they will distort how the new algorithm works. A quick way to do this is by right-clicking any spacer, choosing Select > All Similar Elements, and pressing
Delete.

Turn this feature on by selecting Style > Page > Enable vertical justification of staves. Then you can reintroduce spacers if there are specific places where the default
spacing needs adjustment.

Other engraving changes in 3.6

In the process of investigating style settings, engraving issues, and creating a new music font, many issues were uncovered which needed to be corrected and which
may have a small impact on the appearance of existing scores. In some cases it is possible to undo these manually.

Beam spacing

A long-standing error in the interpretation of the beamDistance setting that is defined alongside SMuFL fonts meant that this value was frequently half as big as it
ought to be in MuseScore, including with Emmentaler and Bravura. (MuseScore defines the distance between beams as a percentage of the thickness of a beam, but
for SMuFL the setting is an absolute distance in stave spaces. The normal thickness of a beam is 0.5sp, and the standard distance between beams is also 0.25sp,
which MuseScore interpreted as 25% of 0.5sp, i.e. 0.125sp.)

The new correct interpretation of this value, 50%, will be applied even to existing scores, unless this value had been explicitly overridden. The extra space is added
inwards, so the position of the outermost beams remains the same. If you really want the old, very-tight spacing, set Style > Beams > Beam distance manually to
25%.

Before (beam distance 25%):

After (beam distance 50%):

Ledger line length

In a similar way, MuseScore interpreted this SMuFL value as the total extension of the ledger line beyond the notehead (i.e. x/2 at each side), when the value is
meant to be the extension at each side. This error was also masked by a square cap being used for the line, rather than a straight cap, thus also adding half of the
line thickness at each end.

As with beam spacing, if this setting was not explicitly overridden in the file, a new default will be applied even in old scores, but this will give identical results. If you
did adjust this value, this value will be preserved, but will produce ledger lines that are too long. You can convert the value manually with the formula:

newvalue=(x12)-§1/2)
where x is the previous 'Ledger line length' value, andy is the ‘'Ledger line thickness' value. Or, just use the now correctly-interpreted default settings for each font:
e Leland: 0.35sp

e Bravura, Gonville, Petaluma: 0.40sp
o Emmentaler: 0.38sp

Stem caps and flag positions

Round caps were previously drawn on stems. This has been replaced with a flat cap. Partly this is to make the length of the stem more exact, but mainly it is so that
the round cap does not obscure the design of the tip of the flag symbols in each font. Emmentaler's flags, for instance, are designed with a flat tip; Bravura and Leland
have rounded tips which are not exactly symmetrical.

The placement of flags was also previously at odds with SMuFL fonts: a calculation was made of how much to extend the stem for a given number of flags, and then
the flag symbol was drawn with the top or bottom of its bounding box at the end of the stem. Now, the presence of flags does not affect stem length (i.e. a normal

183



length stem is used for a note according to its vertical position and stem direction) and the flag symbol is then placed with its y=0 at the end of the stem. Any
‘extension’ of the stem is thus determined by the extent to which the flag symbol extends above or below y=0. The flags in Emmentaler, as used within MuseScore,
have been repositioned to reflect this, and to match other SMuFL fonts.

The result of this is that flags may appear slightly lower or higher than they did previously; however, their positioning now reflects the intentions of the designers of
each of the available fonts. Beamed notes are not affected.

Before (Bravura, in 3.5):

SN EE

After (Bravura, in 3.6):

SESELERE

Bracketed accidentals

Previously MuseScore did not add any space between the bounding boxes of accidentals and brackets around them. Now a small amount of padding is added, which
can be customised via Style > Accidentals > Padding inside parentheses.

Before (Bravura, in 3.5):

After (Bravura, in 3.6):
[a} | L

Accidentals in Emmentaler
These have been replaced with those taken from Parnassus. For details, seePR #6747 2.
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Don't Break

REMRTZ $HA

In addition to the system, page, and section breaks familiar from MuseScore 2, the "Breaks & Spacers" palette now contains a new "Don't Break" element. This allows
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you to force two measures to be kept together, for example, if there is some complex passage that spans the measures and you want to make sure they are adjacent.
If both measures don't fit on a system, MuseScore moves them both to the next system. (currently, this leaves a "hole" at the end of the first staff - is this a bug or is
there some purpose behind it?)
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¢ Release notes for MuseScore 3.x &
e Transitioning from version 2 to version 3 &'

Known limitations of MuseScore 3.x

While all members of the development team did their best to make the software easy to use and bug-free, there are some known issues and limitations in MuseScore
3.X.

Local time signatures

The local time signature feature, which allows you to have different time signatures in different staves at the same time, is very limited. You can only add a local time
signature to measures that are empty, and only if there are no linked parts. When adding notes to measures with local time signatures, you can enter notes normally
via note input mode, but copy and paste does not work correctly and may lead to corruption or even crashes. The join and split commands are disabled for measures
with local time signatures.

Regroup Rhythms

The Regroup Rhythms command found under the Tools menu may have unintended side effects, including changing the spelling of pitches and deleting some elements
like articulations, glissandos, tremolos, grace notes and, esp. on undo, ties. Use this tool with caution on limited selections, so that you can tell if any unwanted
changes are made.

Tablature staff linked with standard staff

When entering multiple-note chords on a standard staff in alinked staff/tablature system, the notes should be entered in orderfrom the top (first) string to the bottom
string to ensure correct fret assignment.

This limitation does not apply if entering notes directly onto a tablature staff, or when using arunlinked staff/tablature system.

Mixer

Changing settings in the mixer other than the sound doesn't mark the score 'dirty’. That means if you close a score you may not get the warning "Save changes to the
score before closing?". Changing mixer values are also not undoable.

Header & footer

There is no way to edit Header and Footer in a WYSIWYG manner. The fields in Format -~ Style — Header, Footer are plain text. They can contain "HTML like"
syntax, but the text style, layout, etc. can't be edited with a WYSIWYG editor.
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Known incompatibilities
Hardware incompatibilities

The following software is known to crash MuseScore on startup:

e Samson USB Microphone, driver name "Samson ASIO Driver", samsonasiodriver.dil. More info &
» Digidesign MME Refresh Service. More info &'

e Windows XP SP3 + Realtek Azalia Audio Driver.More info &

¢ Wacom tablet. More info & and QTBUG-6127 &'

Software incompatibilities
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Maple virtual cable is known to prevent MuseScore &' from closing properly.

KDE (Linux) window settings can cause the whole window to move when dragging a note Changing the window settings of the operating system @ avoids the
problem.

Nitro PDF Creator may prevent MuseScore 2 from starting &' on Windows 10, if being used as the default printer. Same for Amyumi/Quickbooks PDF Printer,
see here ' and also some cloud printing services, seehere .

Creative Sound Blaster Z Series ASIO driver mayprevent MuseScore 2 from starting & on Windows 10.

Untrusted Font Blocking policy prevents MuseScore 2 from starting &' (except in debug mode, i.e. using the -d option) on Windows 10. (Solution irthe links
provided here &)

The SteelSeries Engine 3 Audio Visualizer will prevent MuseScore from starting up, or cause MuseScore to crash if the Audio Visualizer is started when
MuseScore is already running.

AVG Internet Security hangs MuseScore

MuseScore requires access to your internet connection with AVG. MuseScore doesn't need an internet connection to function, but if AVG blocks it, MuseScore hangs.
If AVG prompts you, Allow MuseScore and check "Save my answer as a permanent rule and do not ask me next time."
If it doesn't prompt you anymore,

. Open the AVG user interface (right-click on the AVG icon, close to your clock -> Open AVG User Interface)
. Click on Firewall

. Click Advanced Settings

. Click Applications

. Find MSCORE.EXE in the list and double-click it

. Change Application Action to Allow for All

U WNE

Font problem on macOS

MuseScore is known to display notes as square when some fonts are damaged on macOS.
To troubleshoot this issue:

1. Go to Applications -> Font Book

2. Select a font and press #+A to select them all

3. Go to File -> Validate Fonts

4. If any font is reported as damaged or with minor problems, select it and delete it
5. Restart MuseScore if necessary

In this forum article &, a user believes to have found the font "Adobe Jenson Pro (ajenson)" to be the culprit, regardless of not being reported as broken, or
problematic as per the above validation, and solved the problem by deleting that font, so this is worth checking too.

Font problem on Linux

If the default desktop environment application font is set to bold, MuseScore will not display the notes properly.
To troubleshoot this issue (gnome 2.*/MATE users):

1. Right-click on your desktop and select Change Desktop background
2. Click on Fonts tab

3. Set Regular style for Application font

4. Restart MuseScore if necessary

For GNOME 3/SHELL users

. Open the shell and open "Advanced Settings"
. Click on the Fonts option in the list

. Set the default font to something non-bold

. Restart MuseScore if necessary

AWNPE

Save As dialog empty on Linux

Some users reported that the Save As dialog is empty on Debian 6.0 and Lubuntu 10.10.
To troubleshoot this issue:

1. Type the following in a terminal
which mscore

2. The command will answer with the path of mscore. Edit it with your preferred text editor and add the following line at the beginning
export QT_NO_GLIB=1

Launch MuseScore and the problem should be solved.
Glossary

The glossary is a work in progress—please help if you can. You can discuss this page in thedocumentation forum .

The list below is a glossary of frequently used terms in MuseScore as well as their meaning. The differences between American English and British English are
marked with "(AE)" and "(BE)", respectively.

A
Acciaccatura

J A short —grace note which appears as a small note with a stroke through the stem. It is quickly executed and technically takes no value from its associated
note.
Accidental
A sign appearing in front of a note that raises or lowers its pitch. The most common accidentals are -sharps, —flats or —naturals, but double sharps and
double flats are also used. Also - koron, and —sori and other quarter tone accidentals. Accidentals affect all notes on the same -staff position only for the
remainder of the measure in which they occur, but they can be canceled by another accidental. In notes tied across a — barline, the accidental continues across
the — barline to the tied note, but not to later untied notes on the same -staff position in that measure.

Ambitus

Note (or vocal) range used in a —staff. Used particularly inEarly Music
Anacrusis

See —Pickup measure.
Anchor

The point of attachment to the score of objects such as Text and Lines: When the object is dragged, the anchor appears as small brown circle connected to the
object by a dotted line. Depending on the object selected, its anchor may be attached to either (a) a note (e.g. fingering), (b) a staff line (e.g. staff text), or (c) a
barline (e.g. repeats).
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Appoggiatura
A long —grace note which takes value from its associated note. Its functions include: passing tone, anticipation, struck suspension, and escape tone.
Arpeggio
An arpegagio tells the performer to break up the chord into the constituent notes, playing them separately and one after the other. An arrow on the arpeggio
indicates the direction in which the player should play the notes of the chord.

| |
3o
‘PJ

AL

B

Bar (BE)

See —measure.
Barline

Vertical line through a —staff, staves, or a full —system that separates —measures.
Beam

Notes with a duration of an —eighth & or shorter either carry a ~flag or a beam. Beams are used for grouping notes.
BPM

Beats Per Minute is the unit for measuring tempo, traditionally counted in quarter note durations. See -metronome mark
Breve
Brevis

A double whole note or breve is a note that has the duration of two whole notes.

c

Caesura
A caesura (//) is a brief, silent pause. Time is not counted for this period, and music resumes when the director signals.
Cent
An interval equal to one hundredth of a semitone.
Chord
A group of two or more notes sounding together. To select a chord in MuseScore, pressshift and click on a note. In thelnspector, however, the word "Chord"
only covers notes in the same voice as the selected note(s).
Clef
Sign at the beginning of a —staff, used to tell which are the musical noteson the lines and between the lines.
Clefs are very useful for - transposition.
Concert pitch
Enables you to switch between concert pitch and transposing pitch (seeConcert pitch and Transposition).
Crotchet (BE)

See - Quarter note.

D

Double Flat
A double flat (bb or ) is a sign that indicates that the pitch of a note has to be lowered two semitones.
Double Sharp
A double sharp (## or 0) is a sign that indicates that the pitch of a note has to be raised two semitones.
Demisemiquaver (BE)
A thirty-second note.
Duplet
See —tuplet.
Dynamic
A symbol indicating the relative loudness of a note or phrase of music—such asmf (mezzoforte), p (piano), f (forte) etc., starting at that note.

Dynamic, Single note
A dynamic marking which applies only to one note—such as sfz (sforzando), fp (fortepiano) etc.

E

Edit mode
The program mode from which you can edit various score elements.
Eighth note
A note whose duration is an eighth of a whole note (semibreve). Same as a quaver (BE).
Endings
See -volta.
Enharmonic notes
Notes that sound the same pitch but are written differently. Example: G# and Ab are enharmonic notes.

F

Flag
See —beam.
Flat

Sign (b) that indicates that the pitch of a note has to be lowered one semitone.
G

Grace note
Grace notes appear as small notes in front of a normal-sized main note. See -acciaccatura and —appoggiatura.
Grand Staff (AE)
Great Stave (BE)
A system of two or more staves, featuring treble and bass clefs, used to notate music for keyboard instruments and the harp.
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Half Note

A note whose duration is half of a whole note (semibreve). Same as a minim (BE).
Hemidemisemiquaver (BE)

A sixty-fourth note.

Interval
The difference in pitch between two notes, expressed in terms of the scale degree (e.g. major second, minor third, perfect fifth etc.). Sedegree (Music) &'
(Wikipedia).

J

Jump

In MuseScore, "jumps" are notations such as "D.S. al Coda", found in the "Repeats & Jumps" palette.

K

Key Signature
Set of —sharps or —flats at the beginning of the —staves. It gives an idea about the tonality and avoids repeating those signs all along the -staff.
A key signature with B flat means F major or D minor tonality.
Koron
An Iranian - accidental which lowers the pitch of a note by a quarter tone (in comparison to the —flat which lowers a note by a semitone). It is possible to use
this accidental in a - key signature.
See also - Sori.

L

Longa
Alonga is a quadruple whole note.
Ledger Line
Line(s) that are added above or below the staff.

M

Measure (AE)
A segment of time defined by a given number of beats. Dividing music into measures provides regular reference points to pinpoint locations within a piece of
music. Same as — bar (BE).
Metronome mark
Metronome marks are usually given by a note length equaling a certain playback speed in -BPM. In MuseScore, metronome marks are used inTempo texts.
Minim (BE)
See —Half note.

N

Natural
A natural (%) is a sign that cancels a previous alteration on notes of the same pitch.

Normal mode
The operating mode of MuseScore outside note input mode or edit mode: press Esc to enter it. InNormal mode you can navigate through the score, select and
move elements, adjust Inspector properties, and alter the pitches of existing notes.

Note input mode
The program mode used for entering music notation.

(o}
Operating System
oS

Underlying set of programs which set up a computer, enabling additional programs (such as MuseScore). Popular OSes are Microsoft Windows, macOS, and
GNU/Linux.
Not to be confused with a sheet music - system.

P

Part
Music to be played or sung by one or a group of musicians using the same instrument. In a string quartet, 1st part = Violin 1, 2nd part = Violin 2, 3rd part =
Viola, 4th part = Cello, in a choir there might be parts for soprano, alto, tenor and bass. A part has one or more - staves (e.g. Piano has 2 staves, Organ can
have 2 or 3 staves).

Pickup Measure (also known as an Anacrusis or Upbeat)
Incomplete first measure of a piece or a section of a piece of music. See Measure duration and Create new score: Pickup measure. Also Exclude from measure

count.
Q
Quadruplet
See —tuplet.

Quarter note

A note whose duration is a quarter of a whole note (semibreve). Same as a crotchet (BE).
Quaver (BE)

See - eighth note.
Quintuplet

See —tuplet.

R

Respell Pitches

Tries to guess the right accidentals for the whole score (see Accidentals).
Rest

Interval of silence of a specified duration.

Re-pitch mode
Allows you to rewrite an existing passage of music by changing the note pitches without altering the rhythm.

S
Semibreve (BE)
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A whole note (AE). It lasts a whole measure in 4/4 time.
Semiquaver (BE)
A sixteenth note.
Semihemidemisemiquaver (Quasihemidemisemiquaver) (BE)
An hundred and twenty eighth note.
Sextuplet
See —tuplet.
Slash chord
See Slash chord & (Wikipedia).
Slash notation
A form of music notation using slash marks placed on or above/below the staff to indicate the rhythm of an accompaniment: often found in association with
chord symbols. There are two types: (1) Slash notation consists of a rhythm slash on each beat: the exact interpretation is left to the player (seeFill with
slashes); (2) Rhythmic slash notation indicates the precise rhythm for the accompaniment (seeToggle rhythmic slash notation).
SFzZ
A virtual instrument format supported by MuseScore (along with ~SoundFonts). An SFZ library consists of one or more SFZ text files, each defining a particular
instrument setup, and many audio sound samples.
Sharp
Sign (#¥) that indicates that the pitch of a note has to be raised one semitone.

Slur

A curved line over or under two or more notes, meaning that the notes will be played smooth and connected/égato).
See also - tie.

=

Sori
An Iranian - accidental which raises the pitch of a note by a quarter tone (in comparison to the sharp which raises it by a semitone). It is possible to use this
accidental in a - key signature.
See also - Koron.

SoundFont
A virtual instrument format supported by MuseScore (along with -SFZ). A SoundFont is a special type of file (extension .sf2, or .sf3 if compressed) containing
sound samples of one or more musical instruments. In effect, a virtual synthesizer which acts as a sound source for MIDI files. MuseScore 2.2 comes with the
SoundFont "MuseScore_General.sf3" pre-installed.

Spatium (plural: Spatia) / Space / Staff Space / sp. (abbr./unit)
The distance between the midpoints of two lines of a music staff (or one-quarter the size of the full five-line staff, assuming a hypothetical staff line thickness of
0). The sizes of most elements in the score are based on this setting (see Page settings).

Staff (AE) / Staves (plural)
A set of lines and spaces, each representing a pitch, on which music is written. In ancient music notation (before 11th century) the staff may have any number of
lines.

Staff Space
See Spatium (above).

Stave (BE)
See Staff (above).

Step-time input
MuseScore's default note input mode, allowing you to enter music notation one note (or rest) at a time.

System
Set of staves to be read simultaneously in a score.

See also — Operating System (OS).

-

=
®

A curved line between two or more notes on the same pitch to indicate a single note of combined duration:

e Quarter note + Tie + Quarter note = Half note

e Quarter note + Tie + Eighth note = Dotted Quarter note

e Quarter note + Tie + Eighth note + Tie + 16th note = Double Dotted Quarter note
See also - slur.

Transposition

The act of moving the pitches of one or more notes up or down by a constaninterval. There may be several reasons for transposing a piece, for example:

1. The tune is too low or too high for a singer. In this case the whole orchestra will have to be transposed as well—easily done using MuseScore.

2. The part is written for a particular instrument but needs to be played by a different one.

3. The score is written for an orchestra and you want to hear what the individual instruments sound like. This requires changing the transposing instrument
parts to concert pitch.

4. A darker or a more brilliant sound is desired.

Triplet
See —tuplet.

Tuplet
A tuplet divides its next higher note value by a number of notes other than given by the time signature. For example a triplet divides the next higher note value
into three parts, rather than two. Tuplets may be: - triplets, —duplets, —quintuplets, and other.

u
Upbeat
See - pickup measure.
\"
Velocity

The velocity property of a note controls how loudly the note is played. This usage of the term comes from MIDI synthesizers. On a keyboard instrument, it is the
speed with which a key is pressed that controls its volume. The usual scale for velocity is O (silent) to 127 (maximum).

Voice
Polyphonic instruments like Keyboards, Violins, or Drums need to write notes or chords of different duration at the same time on the same -staff. To write such
things each horizontal succession of notes or chords has to be written on the staff independently. In MuseScore you can have up to 4 voices per staff. Not to be
confused with vocalists, singing voices like soprano, alto, tenor and bass, which are better viewed as instruments.

<

olta

In a repeated section of music, it is common for the last few measures of the section to differ. Markings called voltas are used to indicate how the section is to
be ended each time. These markings are often referred to simply as —endings.

External links

o http://www.robertcarney.net/musical-terms-definitions.htm &'
o https://en.wikipedia.org/wiki/List_of musical_symbols &
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